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License Agreement Rev. 10/95

This is a legal agreement between you, the end user, and
Thunder Scientific Corporation ("TSC").  The enclosed
Thunder Scientific Corporation software program (the
"SOFTWARE ") is licensed by Thunder Scientific
Corporation to the original customer and any subsequent
transferee of the product for use only on the terms set
forth here.  Please read this license agreement.  If you do
not agree to these terms, return the full product with
proof of purchase within 30 days for a full refund.

•GRANT OF LICENSE.  TSC grants to you the right
to use one copy of the enclosed SOFTWARE on a single
terminal connected to a single computer (i.e. single CPU)
or to a network server.  If you install the SOFTWARE on
a network server, you must purchase a separate copy of
the SOFTWARE for each computer terminal that will be
used to operate the SOFTWARE.  If the anticipated
number of users of the SOFTWARE will exceed the
number of applicable Licenses, then you must have a
reasonable mechanism in place to ensure that the number
of persons using the SOFTWARE concurrently does not
exceed the number of Licenses.  The SOFTWARE is for
use with a TSC humidity generator only, and is not to be
used nor is intended for use with any other type of
system or for any other purpose.

•COPYRIGHT.  The SOFTWARE is owned by TSC
and is protected by United States copyright laws and
international treaty provisions.  You may either (a) make
two copies of the SOFTWARE solely for backup or
archival purposes provided that you reproduce all
copyright and other proprietary notices that are on the
original copy of the SOFTWARE provided to you, or (b)
transfer the SOFTWARE to a single hard disk provided
you keep the original solely for backup or archival
purpose.  You may not copy the written materials
accompanying the SOFTWARE.

•OTHER RESTRICTIONS.  You may not rent or
lease the SOFTWARE, but you may transfer the
SOFTWARE and accompanying written materials on a
permanent basis provided you retain no copies and the
recipient agrees to the terms of this Agreement.  You
may not reverse engineer, decompile, disassemble, or
create derivative works from the SOFTWARE.

•MULTIPLE OPERATING SYSTEMS.  If  the
SOFTWARE package contains media for multiple
operating systems, then you may use only the
SOFTWARE appropriate for the operating system of
your single-user computer or LICENSED COMPUTER
NETWORK.  You may not use the other disks on
another computer or computer network, or loan, rent,
lease, or transfer them to another user except as part of
the permanent transfer (as provided above) of all
SOFTWARE and written materials.

• GOVERNMENT LICENSEE.  If you are acquiring
the SOFTWARE on behalf of any unit or agency of the
United States Government, the following provisions
apply:

The Government acknowledges TSC's representation
that the SOFTWARE and its documentation were
developed at private expense and no part of them is in
the public domain.

The Government acknowledges TSC's representation
that the SOFTWARE is "Restricted Computer Software"
as that term is defined in Clause 52.227-19 of the Federal
Acquisition Regulations (FAR) and is "Commercial
Computer Software" as that term is defined in Subpart
227.471 of the Department of Defense Federal
Acquisition Regulations Supplement (DFARS).  The
Government agrees that:

(i) if the SOFTWARE is supplied to the
Department of Defense (DOD), the SOFTWARE is
classified as "Commercial Computer Software" and the
Government is acquiring only "restricted rights" in the
SOFTWARE and its documentation as that term is
defined in Clause 252.227-7013(c) (1) of the DFARS,
and

(ii) if the SOFTWARE is supplied to any unit or
agency of the United States Government other than
DOD, the Government's rights in the SOFTWARE  and
its documentation will be as defined in Clause 52.227-19
(c) (2) of the FAR.

RESTRICTED RIGHTS LEGEND.  U s e ,
duplication, or disclosure by the Government is subject
to restrictions as set forth in subparagraph (c) (1) (ii) of
the Rights in Technical Data and Computer Software
clause at DFARS 252.227-7013.  Thunder Scientific
Corporation, 623 Wyoming SE, Albuquerque, NM
87123.

•EXPORT LAW ASSURANCES.  You acknowledge
and agree that the SOFTWARE  is subject to restrictions
and controls imposed by the United States Export
Administration Act (the "Act") and the regulations
thereunder.  You agree and certify that neither the
SOFTWARE nor any direct product thereof is being or
will be acquired, shipped, transferred or reexported,
directly or indirectly, into any country prohibited by the
Act and the regulations thereunder or will be used for
any purpose prohibited by the same.

• GENERAL.  This Agreement will be governed by the
laws of the State of New Mexico, except for that body of
law dealing with conflicts of law.

Should you have any questions concerning this
Agreement, or if you desire to contact TSC for any
reason, please write:  Thunder Scientific Corporation,
623 Wyoming NE, Albuquerque, NM  87123



Warranty

Thunder Scientific Corporation warrants that the media on which the Software is
distributed will be free from defects for a period of twelve (12) months from date of
original purchase.

During the warranty period, we will at no charge, repair or replace, at our option, any
product that proves to be defective, provided you return the product to Thunder Scientific
Corporation.  This warranty does not apply to any product that has been repaired, serviced,
altered, or modified by anyone other than an authorized representative of Thunder
Scientific Corporation.

Thunder Scientific Corporation shall not be liable for any consequential, special, incidental,
direct or other damage, loss, or expense arising out of or connected with the manufacture,
programming, packaging, storage, delivery (including any delay in or failure to deliver), or
use of any products, whether or not resulting from negligence or breach of contract, except
to the extent that those items sold and warranted by Thunder Scientific Corporation shall be
repaired or replaced in accordance with the previously stated terms of this warranty
contract.  The repair or replacement of a product is your exclusive remedy.

THUNDER SCIENTIFIC CORPORATION MAKES NO OTHER WARRANTY OR
REPRESENTATION OF ANY KIND, EXPRESS OR IMPLIED, AND NO WARRANTY
SHALL BE IMPLIED BY LAW.

Copyright

©1997-2006 Thunder Scientific Corporation
623 Wyoming Blvd. SE
Albuquerque, NM 87123, USA

This document contains proprietary information which is protected by copyright.  All rights
are reserved.  No part of this document may be reproduced or transmitted in any form or by
any means, electronic or mechanical, including photocopying and recording, for any
purpose without the prior written consent of Thunder Scientific Corporation.
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Getting Started
This section will provide you with enough information to quickly install ControLog™ and
begin using it right away with your Model 2500 Humidity Generator.  With an example to
guide you through startup and shutdown of the generator, you will gain familiarity with the
use of ControLog.

The remainder of this manual is intended to provide you with a basic understanding of the
many features of the ControLog software.   However, fundamental operation of the Model
2500 is assumed, and may be found in the Operation and Maintenance Manual provided with
the generator.

Installing ControLog

a. Insert the ControLog distribution disk into the appropriate disk drive. Locate and
launch the program labeled Setup.exe.

b. Follow the on screen directions.  The setup program automatically installs all required
files on to your hard drive.

c. Once the installation is complete, remove and store the distribution disks.
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What Happens During Installation

The installation process creates some new directories on your hard drive.  The following is a
list of default directories created, assuming you choose the defaults recommended by the
installation program.

The installer also places ControLog and several other supporting files on your hard drive.
Since some of the supporting files are also used by programs other than ControLog, files
already existing on the hard drive with newer dates than those on the installation disks will
not be overwritten, and the newer versions will remain.

•  c:\Program Files\2500 ControLog
•  c:\Program Files\2500 ControLog\datafiles
•  c:\Program Files\2500 ControLog\profiles
•  c:\Program Files\2500 ControLog\rptfiles
•  c:\Program Files\2500 ControLog\sysfiles

 Connecting the Computer

ControLog communicates with the 2500 through an RS-232 communication connection on
COM1, COM2, COM3, or COM4.  When using the DA9800, connect the 2500 to COM1, as
the DA9800 already occupies COM3 and 4.

a. Using the 9 pin extender cable provided, connect the computer's 9 pin male serial port
connector to the 9 pin female console port connector of the Model 2500 (upper
connector, left side).  If your cable ever becomes damaged or lost, you can replace it
with a standard 9 pin male to female serial cable (Radio Shack part number 26-117).

VIDEO

LPT1

COM1

2500 BENCHTOP
LAPTOP
COMPUTER
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b. If your computer's serial port has a 25 pin connector, then you will also need a 25 pin
female to 9 pin male AT port adapter which converts your 25 pin connector to the
newer 9 pin AT style and pinout (Radio Shack part number 26-287).

VIDEO

LPT1

COM1

2500 BENCHTOP

LAPTOP
COMPUTER

9 TO 25 PIN
AT PORT ADAPTER

Starting ControLog

This section is intended to quickly familiarize you with the operation of ControLog.  
If used with a DA9800 Acquisition System, please turn the power to the HP34970A's
OFF.  This will prevent any initial confusion about its use, as the data acquisition 
system will be discussed in detail in a later section.  At startup, ControLog will detect 
that the data acquisition system is unavailable and will automatically revert to the 
simpler operational mode discussed in this section.

a. Ensure that the computer's serial port is properly connected to the 2500.

b. From Windows 95 or NT click Start, then locate and click on 2500 ControLog in
the Programs menu.

c. Once loaded and initialized, the following screen appears.  Depending on your screen
resolution, the location of the four windows may be different from that shown below.
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The ControLog program always powers up showing the four most commonly used windows;
Control Parameters, Calculated Humidity Parameters, Graph, and Status Log.

The Control Parameters window is similar to the display of the 2500 and reflects the
current set points and actual operating values.

The Calculated Humidity Parameters window lists the current humidity value expressed in
a variety of different ways.

The Graph window is used to display a graph of any of the operating parameters of the 2500
against time.  Since all system data is stored automatically at regular intervals during a run,
any of the parameters may be graphed at any time

The Status Log window contains a chronology of system events such as startups, shutdowns,
setpoint changes, and system errors.
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Setting the Communication Parameters

In order for ControLog to be able to communicate with the 2500, the COM port must be
properly selected and the serial communication parameters must match those of the humidity
generator.  ControLog initially defaults to COM1, 2400 baud, 8 data bits, 1 stop bit, no
parity.  Since any change made to these settings is remembered by the system, they only need
to be set once.

a. Select Communication Settings from the !  menu (left of the File menu).  The
following window appears.

b. In the Serial Port Settings area, select the Comm Port which is currently connected to
the 2500.  If using the computer in the DA9800, set the Comm Port to COM1.

c. Set the Baud Rate, Data Bits, Stop Bits, and Parity to match the current Console Port
Parameters of the 2500.  For information regarding the Console Port Parameters of
the 2500, refer to the Operation and Maintenance Manual section 3.3 Editing System
Coefficients and Parameters, and section 3.3.2.5 Console Port Parameters.

d.  Click OK.  The Comm Port selected will be initialized with the Baud Rate, Data Bits,
Stop Bits, and Parity settings.  If successful, the Communication Settings window will
close.  If for some reason the Comm Port is unavailable or fails initialization, then an
error message will appear and the Communication Settings window will remain open.
If this occurs, change the settings and try again.

Initiating Generate Mode

This example will illustrate how to start the generator, generate a few Relative Humidity
Points, and then shutdown the system.  Generate mode is a manual operation mode where the
system responds immediately to any setpoint change requests, then continues at that setpoint
until you manually change it.

For the purposes of this example, assume that the first point to be generated is 30% Relative
Humidity, with a 10 liter per minute flow rate, at a test temperature of 21.1°C.
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Start the Generate Mode

a. Select Generate from the Run menu

When Generate mode begins, all fields on the Control Parameters window and the
Calculated Humidity Values window begin to update, and the Status Log shows the
time that the Generate mode was started.

Change the Setpoints

b. Click on the %RH Setpoint field of the Control Parameters window.
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The following dialog box will appear.

c. Using either the on screen keypad or the keyboard, enter a setpoint value of 30.  Then
click OK.

Notice that the %RH setpoint field updates to the new value and the values in the
Actual column begin moving toward the new setpoint.

d. Change the flow setpoint to 10 by clicking on the flow setpoint field and entering a
new value just as you did previously.

e. Verify the setpoint value for saturation temperature is set correctly.  Change it if
needed using the same method.



8 Getting Started

Display a Graph

f. Select Enable Strip Chart from the Graph menu to see a real time graph of the
system performance.

Within a few minutes the graph will begin updating (once there are at least two or
three data points to display).  The graph continues to show a history of generated
Relative Humidity vs. elapsed time.  By default, the data used to draw the graph is
initially set to a data storage interval of one minute.  The graph will therefore update
at this frequency.
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Changing the %RH Setpoint

Once the %RH has stabilized at 30% for a while,  change to a 50% Relative Humidity
setpoint.

a. Click on the %RH setpoint field.

b. Enter 50 as the new setpoint.

c. Click OK.

Allow the system to stabilize at the new %RH.  The graph should continue to update
indicating the current %RH being generated.

Shutdown

Performing a shutdown causes the generator to vent the saturation pressure to ambient, turns
off the refrigeration compressor and fluid pump, then disables the generator's control
routines.  Now that this trial run is complete, the system is ready to be shutdown.

a. Select Shutdown from the Run menu.

Once the generator is shut down, the system may prompt you to save the system data
which was acquired during the run.
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b.  Choosing Yes and supplying a valid filename causes the data to be stored to disk for
later use.

Although files may be stored with any extension (or none at all), a  .dat  extension is
recommended for data files.  By default, the files will be stored in the c:\Program
Files\2500 ControLog\datafiles.

When used with the DA9800 Data Acquisition System, automatic file saving is
available with auto file naming using a time date stamp method.  For instance, with
auto file saving enabled, a file might be saved with a name such as
S19980915175846.dat.  The first 8 numeric digits represent the date in yyyymmdd
format, the second six digits represent the time in 24 hour format, and the preceding s
indicates that this is system data.



Windows 11

2

Windows
ControLog displays information in several different windows, all of which are moveable
within the ControLog screen area, many of which are also resizeable.

While only the windows of immediate interest are generally viewed on the screen at any one
time, all available windows are listed and accessible through the Window menu, and may be
viewed at any time, arranged in any manner.

Even though a particular window may not currently be visible, its display information is still
being computed and updated continuously.

Note that since the Control Parameters window is of significant importance to the operation
of the system, it does not have a close or minimize box and can't be put away.
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Window Reset

Selecting Reset from the Window menu restores the look of the screen to its power up
default setting.

This operation hides all windows with the exception of more commonly used ones: Control
Parameters, Calculated Humidity Parameters, Graph, and Status Log.  These remaining
windows are sized and arranged in a standardized format, depending upon you computer's
screen resolution.

Control Parameters

The Control Parameters window contains all the control and measurement parameters critical
to the operation of the humidity generator.  Notice that each parameter consists of a brief
title, unit of measurement, and the data values for Setpoint, Actual, and Error Estimate as
applicable.

All parameters are listed in an order similar to the generator's display with the exception of
the first listed parameter.  The first parameter on the Control Parameters window is the active
humidity control parameter.  For instance, if ControLog were set to control the generator on
dew point, then Dew Point would be listed as the first parameter rather than %RH.
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In the Setpoint column, each of the system controlled parameters is listed.  However, Sat
Pressure can not be changed here, and is listed for information purposes only.  If the system
is to be controlled on Sat Pressure for any reason, refer to Saturation Pressure Control Mode.

The Actual column lists instantaneous values for each of the systems measured temperatures,
pressures, and flow.  Note that the humidity control value at the top of the list is not a
measured value but rather is a computed value based on the measurements of saturation and
chamber temperatures and pressures.

The +/- Error Estimate column is a representation of the anticipated worst case error band of
the system for each of the parameters listed at the current operating conditions.  Pressure
error band estimates are based upon expected performance of the pressure transducers in
terms of % of full scale, % of reading, and hysteresis errors.  Temperature error band
estimates are based upon both a fixed error tolerance, which is constant across the entire
scale, and self heating errors, which are dependent upon the applied temperature.

The temperature and pressure error estimates are then used to compute error band estimates
for humidity at the current operating conditions.  Since the generator does not depend upon
flow for the computation of any of the temperature, pressure, or humidity values, no error
estimate is computed for it.

Calculated Humidity Parameters

The Calculated Humidity Parameters window contains values of the currently generated
humidity calculated from current system temperatures and pressures.  An Error Estimate
(explained in Control Parameters) is given for each value.  A check mark in front of any item
indicates that the item will be included in printed data when the printer is enabled.



14 Windows

%RH@Pc The %RH calculated at test chamber pressure, Pc, from saturation
pressure, Ps, and saturation temperature, Ts.  Percent Relative
Humidity is the ratio of the amount of water vapor in a given sample to
the maximum amount possible at the same temperature and pressure.
This value ignores possible temperature difference between
saturation and chamber.

%RH@PcTc The %RH calculated at test chamber pressure, Pc, and test chamber
temperature, Tc, from saturation pressure, Ps, and saturation
temperature, Ts.  Percent Relative Humidity is the ratio of the amount
of water vapor in a given sample to the maximum amount possible at
the same temperature and pressure.

Frost Point The Frost Point temperature calculated at test chamber pressure, Pc,
from saturation temperature, Ts, and saturation pressure, Ps.  Frost
Point Temperature is the temperature to which a gas must be cooled in
order to just begin condensing water vapor in the form of frost or ice,
and therefore only exists at values below 0.01 °C.  When operating the
system with indicated Frost Points above 0.01 °C, the values indicated
are to be interpreted as Dew Points.  However, Frost Point is not the
same as Dew Point for values below freezing.  Frost Point is
independent of test chamber temperature.

Dew Point The Dew Point temperature calculated at test chamber pressure, Pc,
from saturation temperature, Ts, and saturation pressure, Ps.  Dew
Point Temperature is the temperature to which a gas must be cooled in
order to just begin condensing water vapor in the form of dew.
Generally, Dew Point exists at temperatures above freezing.  In many
instances, Dew Point may actually exist at indicated values below
freezing.  However, it is important to note that Dew Point is not the
same as Frost Point.  Dew Point is independent of test chamber
temperature.

PPMv Parts Per Million by Volume, PPMv, calculated from saturation
temperature, Ts, and saturation pressure, Ps.  Parts Per Million by
Volume is a ratio of the number of molecules of water vapor to the
number of molecules of the other constituents in the gas.  Once
established, PPMv is pressure and temperature insensitive, and is
therefore independent of test chamber temperature and test chamber
pressure.

PPMw Parts Per Million by Weight, PPMw, calculated from saturation
temperature, Ts, saturation pressure, Ps, and the molecular weight of
the carrier gas.  Parts Per Million by Weight is a ratio of the weight of
the water vapor in a sample to the weight of the remaining constituents
in the gas.  Once established, PPMw is pressure and temperature
insensitive, and is therefore independent of test chamber temperature
and test chamber pressure.

Grains/lb Grains per pound is calculated from saturation temperature, Ts,
saturation pressure, Ps, and the molecular weight of the carrier gas.
Grains per pound is a ratio of the weight, in grains, of water vapor to
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the weight, in pounds, of the other constituents in the gas.  (7000
grains = 1 pound).  Once established, Grains/lb is pressure and
temperature insensitive, and is therefore independent of test chamber
temperature and test chamber pressure.

Absolute Humidity Absolute Humidity calculated from saturation temperature, Ts,
saturation pressure, Ps, test chamber temperature, Tc, and test chamber
pressure Pc.  Absolute Humidity is the weight of the water vapor per
unit volume of humidified gas.

Dry Air Density Partial Dry Air Density calculated from saturation temperature, Ts,
saturation pressure, Ps, test chamber temperature, Tc, and test chamber
pressure Pc.  Dry Air Density is the partial density in weight per unit
volume of only the dry air portion of a moist air sample.  In other
words, if the water vapor were removed from a fixed volume of air, the
remaining dry air would exhibit this density.

Moist Air Density Moist Air Density calculated from saturation temperature, Ts,
saturation pressure, Ps, test chamber temperature, Tc, and test chamber
pressure Pc.  Moist Air Density is the total weight per unit volume of a
moist air sample.  This density includes both the weight of the air and
the weight of the water vapor.

Enthalpy Enthalpy calculated from saturation temperature, Ts, saturation
pressure, Ps, test chamber temperature, Tc, and test chamber pressure
Pc.  Enthalpy is a measure of the amount of energy required to change
a gas from one temperature/humidity value to another.  In application,
enthalpy is not used as an absolute value, but rather it is the difference
in enthalpy between two distinct points which is of interest.  The
datum point which results in zero enthalpy was therefore arbitrarily
chosen at a test temperature of 0 °C and 0 %RH.  Applying enthalpy is
a matter of computing the difference in enthalpy between two or more
distinct data points.

Specific Humidity Specific Humidity calculated from saturation temperature, Ts,
saturation pressure, Ps, and test chamber pressure Pc.  Specific
Humidity is a ratio of the weight of the water vapor to the total weight
of the humidified gas.  Specific Humidity is independent of test
chamber temperature.

Mixing Ratio (V) Mixing Ratio by Volume calculated from saturation temperature, Ts,
saturation pressure, Ps, and test chamber pressure Pc.  Mixing Ratio by
Volume is a ratio of the partial pressure of the water vapor to the
partial pressure of the remaining constituents in the sample.  Mixing
Ratio by Volume is independent of test chamber temperature.

Mixing Ratio (W) Mixing Ratio by Weight calculated from saturation temperature, Ts,
saturation pressure, Ps, and test chamber pressure Pc.  Mixing Ratio by
Weight is a ratio of the weight of the water vapor to the weight of the
remaining constituents in the sample.  Mixing Ratio by Weight is
independent of test chamber temperature.
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% by Volume Percent by Volume calculated from saturation temperature, Ts,
saturation pressure, Ps, and test chamber pressure Pc.  Percent by
Volume is a ratio (expressed as a percentage) of the partial pressure of
the water vapor to the total pressure of the sample.  Percent by
Volume is independent of test chamber temperature.

% by Weight Percent by Weight calculated from saturation temperature, Ts,
saturation pressure, Ps, and test chamber pressure Pc.  Percent by
Weight is a ratio (expressed as a percentage) of the weight of the
water vapor to the total weight of the sample.  Percent by Weight is
independent of test chamber temperature.

Vapor Mole Fraction Vapor Mole Fraction calculated from saturation temperature, Ts,
saturation pressure, Ps, and test chamber pressure Pc.  Vapor Mole
Fraction is the mole fraction of water vapor in a sample.

Dry Air Mole Fraction Dry Air Mole Fraction calculated from saturation temperature, Ts,
saturation pressure, Ps, and test chamber pressure Pc.  Dry Air Mole
Fraction is the mole fraction of the dry air portion of a sample.  The
dry air portion is considered to be all constituents in a gas exclusive of
the water vapor.

Graph

The Graph window is a powerful tool used to view previously generated data or to monitor
the current data in real time using the strip chart feature.  Graph features are accessed either
through the Graph menu,

or from the toolbar at the top of the Graph window.
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Use of the graph is fully explained in Graphing.

Status Log

The Status Log contains chronological information about the system status, logging changes
in operational modes, changes in setpoint, and runtime errors due to communication or
mechanical difficulties the generator encounters.

To print the contents of the status log, select Print Status Log from the File menu.

Should the status log become very large, the entire log may be cleared by selecting Clear
Status Log from the File menu.
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System Timing

The System Timing window shows information about the current operating mode (Generate
or Auto) and the timing associated with it such as the amount of run time elapsed at the
current humidity conditions.  This window may be shown at any time by selecting System
Timing from the Window menu.

Tabular Data

The Tabular Data window contains a spreadsheet type view of actual system data including
both system control parameters (Saturation Temperature, Saturation Pressure, Flow, etc.) and
calculated humidity parameters (%RH, Frost Point, Dew Point, etc.)  Tabular data is always
stored in SI units regardless of the setting of the system units.  For a further discussion of the
Tabular Data information, refer to Data Storage & Retrieval.
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Profile

 A Profile is a list of humidity, temperature, flow, and time parameters that are used during
automated control of the 2500 Generator.  The Profile essentially programs the
computer/controller operations.  The profile form stores this user entered information.
Further discussion of the Profile form is found in Auto-Profiling.

Auxiliary Parameters

The Auxiliary Parameters window contains values of vapor pressure and enhancement factors
calculated from current system temperatures and pressures.  A check mark in front of any
item indicates that the item will be included in printed data.  This window may be shown at
any time by selecting Vapor Pressures from the Window menu.

SVP@Tc The Saturation Vapor Pressure calculated at test chamber temperature,
e(Tc), is the maximum allowable vapor pressure in a sample of gas at
that temperature.  For Tc ≥ 0.01 °C, vapor pressure is computed with
respect to water. For Tc < 0.01 °C, vapor pressure is computed with
respect to ice.
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SVP@Ts The Saturation Vapor Pressure calculated at saturation temperature,
e(Ts), is the maximum allowable vapor pressure in a sample of gas at
the saturation temperature.  For Ts ≥ 0.01 °C, e(Ts) is computed with
respect to water.  For Ts < 0.01 °C, e(Ts) is computed with respect to
ice.

SVP@Td The Saturation Vapor Pressure calculated at dew point temperature,
ew(Td), with respect to water, is commonly referred to as the dew point
vapor pressure.  For Td<0.01 °C, this vapor pressure may also be
computed at the frost point temperature, Tf, with respect to ice.  While
ew(Td) is vapor pressure with respect to water at the dew point
temperature, and ei(Tf) is vapor pressure with respect to ice at the frost
point temperature, then for Td < 0.01 °C, ew(Td)=ei(Tf) even though
Td≠Tf.

F@PcTc The Enhancement Factor calculated at test chamber pressure, Pc and
test chamber temperature, Tc.

F@PsTs The Enhancement Factor calculated at saturation pressure, Ps and
saturation temperature, Ts.

F@PcTd The Enhancement Factor calculated at test chamber pressure, Pc and
dew point temperature, Td.
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Statistical Analysis

The Statistical Analysis window provides a method to monitor the stability of the generator.
The statistical mean and standard deviation are calculated for each of the parameters listed
and are updated and displayed continuously in real time.

Both the mean and standard deviation are computed from a fixed size moving data set which
contains only the most recent data.

To change the size of the data set, click on either the Mean or StdDev column headers while
holding the Control key.  A dialog box appears prompting for a new data set size.
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Generating
Generate mode is used to operate the system when exact humidity points or associated time
intervals have not been determined, when data must be viewed and/or verified manually
before proceeding to the next humidity point, or when you just wish to have more immediate
control over the humidity.

When in the Generate mode of operation, the system will control at the currently entered
setpoint indefinitely.  Any time that a setpoint is changed, the system immediately begins
adjusting to that new value, then again controls it at that new point indefinitely.  Generate
mode offers the flexibility to change the setpoint at any time, and does not force you into any
set sequence or for any prescribed amounts of time.

The Generate mode also allows you to change the humidity control mode at any time.  For
instance, the system may be controlling %RH, then immediately switched to a dew point
control mode.

It is assumed in this section that either the 9800 Data Acquisition System has already been
configured (see 9; Data Acquisition) or it was OFF while ControLog was started.

Startup

To start the system in the Generate mode, select Generate from the Run menu.

When Generate is selected, the 2500 is then instructed to startup and initiate the generation
process.  The Generate menu item is designated with a check mark, indicating the generate
process is active.

When Generate mode begins, all fields on the Control Parameters window and the Calculated
Humidity Values window begin to update, and the Status Log shows the time that the
Generate mode was started.
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Also notice that all of the listed in the Control Parameters window were sent to the 2500 and
it controls at those values.

What Happens in Generate

When the system is placed into Generate mode, gas flows from the gas supply and flow
control valve, through the presaturator, through the saturator, through the expansion valve to
the test chamber.  It then flows through the test chamber to the gas exhaust outlet.

The temperature of the fluid medium surrounding the chamber is controlled at the saturation
setpoint temperature.  Since this fluid medium is common to the chamber and saturator, both
the chamber and saturation temperatures converge toward this value.

Special Considerations in Generate

To prevent condensation on a cold device under test when transitioning upward in
temperature, lower the humidity setpoint prior to changing the saturation temperature
setpoint.  Since it is not always easy to remember which temperature direction causes this
problem, the general rule of thumb is to make temperature transitions at moderate to low
humidities only (near 20 or 30 %RH).

Since the generated Relative Humidity is relative to the measurement of the test chamber
temperature, place the chamber temperature probe as close as possible to the humidity
sensing element of the device.  Heat loads in the chamber will cause temperature gradients
resulting in humidity gradients within the chamber.  Keep heat loads to a minimum if
possible.

Generate may be initiated regardless of the current operating mode.  In other words the
system may be freely switched to Generate mode from either Auto Profile or Shutdown.

If ControLog recognizes that the 9800 Data Acquisition System is connected and powered
on, the Generate mode cannot be enabled until after the Data Acquisition System has been
configured.  See Data Acquisition.

If the 2500 was already running when Generate was initiated, ControLog reads the 2500's
current setpoint values rather than using those in the Control Parameters window.  However,
if ControLog initiated Generate while the 2500 was stopped, the setpoint values are sent
from the Control Parameters window to the 2500.
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Setpoints

Setpoints which may be changed are listed in the Set Pt column of the Control Parameters
window.  Editable setpoints in addition to the top listed humidity parameter include
Saturation Temp, and Mass Flow Rate.

To Change Setpoints

a. With ControLog in the Generate mode and the 2500 running, click once on the
desired setpoint entry field.

A dialog box appears on the screen with a prompt such as Enter a new %RH
setpoint:

b. Using either the keyboard or the on-screen keypad, enter the desired value in the units
indicated in the dialog box.

c. After entering the new value, select OK.  The value you entered should be displayed in
the appropriate setpoint entry field.  (Selecting Cancel will abort the setpoint entry
procedure.)
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What Happens When Changing Setpoints

Setpoints within legal limits are accepted.  If an entry is invalid due either to mistakes in
setpoint entry or out of range conditions, both ControLog and the 2500 will retain the original
setpoint value.

Editing the Saturation Temp setpoint sets the temperature of the fluid medium which flows
around and through the saturator and around the test chamber.  Note that some instruments
installed in the test chamber may produce a heat load, causing a temperature difference
between the saturation temperature and the actual chamber temperature.

When using ControLog with the 9800 Data Acquisition System, current channel readings are
stored prior to the setpoint change.  For a further description of the data storage process, see
Data Acquisition.

Special Considerations When Changing Setpoints

Setpoint changes made from the front panel of the Benchtop will be ignored when ControLog
is executing an Auto Profile (see Auto Profiling).

A Saturation Pressure setpoint may only be entered if saturation pressure is the current
humidity control mode.  In all other humidity control modes, saturation pressure setpoint is
automatically determined by ControLog in order to achieve the desired humidity output.

Units

The Units menu is used to select desired engineering units for display, printing, and graphing
purposes.  The current engineering units are indicated with a check mark.

To Change Units

a. Pull down the units menu.



Generating 27

b. Select the units type to change.

c. From the sub menu, select the desired units.

d. A √ will be placed in front of the currently selected units and all displayed values of
that type will change.

What Happens When Changing Units

The units labels on the affected control and humidity parameter items update to reflect the
new units selection.

All affected data values in the fields on the Control, Calculated Humidity Parameters,
Auxiliary Parameters and Statistical Analysis screens will update within a few seconds to
reflect the change.

If a selected graph item is affected, changing units will update the y-axis values to reflect the
change.

If the printer is enabled and the current data page is not complete, an END OF FORM will be
sent to the printer to allow a new header with the correct units to be printed.

Special Considerations When Changing Units

Changing units may cause the values that are displayed to become very large or very small.
In order to maintain significant digits, values are displayed in a modified scientific notation
form.

M = 106

K = 103

m = 10-3

µ = 10-6

n = 10-9
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This notation is only used for display and printing purposes, not for entry of data or, or for
data storage.  For these cases, standard scientific notation (1.23E3, 1.23E-3, etc.) is used.

Data shown on the Tabular Data window and data stored to disk will always be in SI units
regardless of the units selected.

ControLog units neither affect, or are affected by, the currently selected units of the 2500
itself.

Control Modes

ControLog may be operated in one of several possible Humidity Control modes as listed in
the Mode menu.

Changing the Humidity Control Mode

To select a new humidity control mode, choose the desired mode from the Mode menu.

The Control Parameters window changes to reflect the new Humidity Control mode selected,
and the setpoint value is changed to the equivalent of the previous humidity setpoint.

%RH@Pc Control Mode

%RH@Pc is controlled at a constant value by varying saturation pressure, Ps, to compensate
for any changes in test chamber pressure, Pc.  While %RH@Pc is held constant, all other
humidity parameters may vary.
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%RH@PcTc Control Mode (power-up default)

%RH@PcTc control mode is the one most often used, and is the power-up default mode of
the generator.

%RH@PcTc is controlled at a constant value by varying saturation pressure, Ps, to
compensate for any changes in saturation temperature, Ts, test chamber temperature, Tc, or
test chamber pressure, Pc.  While %RH@PcTc is held constant, all other humidity parameters
may vary.

Frost Point Control Mode

Frost Point is controlled at a constant value by varying the saturation pressure, Ps, to
compensate for changes in either saturation temperature, Ts, or test chamber pressure, Pc.
While Frost Point is held constant other humidity parameters may vary.

Frost Point is independent of test chamber temperature.

Dew Point Control Mode

Dew Point is controlled at a constant value by varying saturation pressure, Ps, to compensate
for any changes in either saturation temperature, Ts, or test chamber pressure, Pc.  While Dew
Point is held constant, other humidity parameters may vary.

Dew Point control mode is valid both above and below 0 °C, and Dew Point is independent
of test temperature.

PPMv Control Mode

PPMv is controlled at a constant value by varying saturation pressure, Ps, to compensate for
any changes in saturation temperature, Ts.  While PPMv is held constant, other humidity
parameters may vary.

PPMv is independent of test chamber pressure and temperature.

PPMw Control Mode

PPMw is controlled at a constant value by varying  saturation pressure, Ps, to compensate for
any changes in saturation temperature, Ts.  While PPMw is held constant, other humidity
parameters may vary.

PPMw is independent of test chamber pressure and temperature.

Saturation Pressure Control Mode

Saturation Pressure, Ps, is controlled at a constant value independent of any other pressure,
temperature, or humidity value.  While saturation pressure is held constant, all humidity
parameters may vary.
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Shutdown

The Shutdown mode is used to stop the system and place it in a depressurized, idle, no gas
flow state.

Initiating a Shutdown

To shut the system down, select Shutdown from the Run menu.

What Happens during Shutdown

A Shutdown causes all gas flow to stop, saturation pressure to vent to ambient, pump and
compressor to stop, and all heating and cooling to cease.

If the Shutdown was caused by a system malfunction, or the system discovered a malfunction
during shutdown, then an entry is made to the Status Log indicating the nature of the error.

Special Considerations during Shutdown

A Shutdown, if followed later by a Generate or Auto Profile causes all system data to be
reinitialized.  Prior to reinitialization, an opportunity is provided via prompt to save any
unsaved data.  If the data was saved upon Shutdown, then no additional prompt is required
and the data reinitializes automatically.

With the Data Acquisition option, automatic naming and saving of data files is available.
Refer to Data Acquisition.
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Data Storage & Retrieval
ControLog stores system data and other calculated parameters to the tabular data window and
a temporary data file \sysfiles\sys.dat.  The data is always stored in SI units.  This same data
is also stored in the tabular data window for use by ControLog's graph.

The items stored consist of elapsed time, date/time, and the measured system parameters in
addition to the calculated humidity parameters and some additional system parameters.  If the
9800 Acquisition is enabled, its data is also stored.

The difference between the tabular data window and the temporary data file is the storage
capacity.  The tabular data window will contain only the most recent 1000 lines of data while
the data file is only limited by the available space on the hard drive.  The graph can only
access the latest 1000 lines of data as currently listed in the tabular data window.

The tabular data window and the temporary data file are cleared at the beginning of each new
run (i.e. from a shutdown condition).

Data Storage Interval

Storing and maintaining data can become a time consuming process.  The more data that is
stored in the tabular data window, the slower and less responsive the computer may seem.
For this reason, some consideration should be given to the amount of data desired, the overall
time span of the data (i.e. hours, days, possibly weeks), and ultimately the data interval.

The data storage interval determines how often the data is stored and also when data will be
printed.  ControLog's power-up default data interval is one minute.

a. Select Data Storage Interval from the File menu.  The following dialog appears.
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b. Enter the new time interval in minutes and select OK.

Saving the System Data

A copy of the current system data file may be saved at any time into a tab separated ASCII
data file which is compatible with most spreadsheet programs.  To save a copy of the current
data file:

a. Select Save Data as... from the File menu.

b. Using the dialog box that appears, select or enter an appropriate path and filename,
then click OK.

Although files may be stored with any extension (or non at all), a  .dat  extension is
recommended for data files.  By default, the files will be stored in the \datfiles directory.

The file is always written in a tab separated data format with a carriage return as the line
terminator.  If using a spreadsheet program to view this data file, be sure to set the column
delimiter to tab and the line delimiter to carriage return in the file opening specifications.

When used with the 9800 Data Acquisition System, automatic file saving and naming is
available at shutdown (when properly configured in the \sysfiles\daux.ini file).  When saved
and named automatically, the files are named 'syyyymmddhhmmss.dat' where
yyyymmddhhmmss is the date/time stamp indicating the time of the run.
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Retrieving Data from Previous Runs

Data that has been saved from a previous run may be imported back into ControLog for
subsequent graphing functions.  A very large data file may also be imported and broken down
into smaller, more manageable chunks.  Files of no more than 1000 lines each are both usable
by ControLog and fit nicely on floppy disks.  Larger files may be imported 1000 lines at a
time then saved to different file names.

a. Select Import Data... from the File menu.

b. From the dialog box that appears, choose the file you wish to import.  When
Automatic file saving is used, the appropriate files start with 'S' and have a date/time
stamp for their names.  Date/time stamped files without the 'S' are not the same and
are used for a different purpose (see Data Acquisition).

If the selected data file contains 1000 lines or less, then this data will replace the current data
in the Tabular Data window.  If the selected data file contains more than 1000 lines, a dialog
box will appear allowing you to select the method for reducing the data to a more
manageable size of 1000 lines or less.

By selecting and dragging a range on the Data Reference table, the Starting Point and
Increment values will be automatically computed.  Or, it may be used just as a reference for
you to select an appropriate starting line, reading in each and every point up to the maximum
allowed.

Values may be entered directly into the Starting Point and Increment fields if desired.  For
instance, if the data file contains 1631 points, using a Starting Point of 200 with an Increment
of 2 results in every other value being read in (200, 202, 204, ... , 1628, 1632) for a total of
716 points.  Using a Starting Point of 500 with an Increment of 1 results in 1000 values being
read in from 500 to 1499.

This data, of 1000 points or less, may be saved to a new data file by following the procedures
in Saving the System Data as previously discussed.
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By conscious use of the Import and Save procedures in turn, a very large data file may be
broken down into a series of smaller, more manageable files of 1000 lines or less.  To retain
all significant data into a series of smaller files, first use an Increment of 1 with a Starting
Point of 0.  This will retrieve lines 0 to 999.  Save the data using the procedures previously
discussed.  Then import with a Starting Point of 1000, saving this data to another file.  Next,
import with a Starting Point of 2000, and so on.
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Printing
A printer may be connected to the parallel printer connection (LPT Port) of your computer.
The printer is used for hardcopy output of system data and other parameters.  While the 2500
generator is operating, the printer output is initiated on a timed interval basis when enabled
through ControLog.  Prior to enabling the printer, ensure that it is properly connected and that
a Page Setup is performed.

Connecting a Printer

Connect a parallel printer to the printer port (LPT1, LPT2, or LPT3) of the computer using a
standard printer cable.

LPT1

PRINTER

LAPTOP
COMPUTER

PRINTER CABLE

The printer may be either a page printer or a line printer.  A page printer, such as a laser
printer, requires a complete page of data before printing.  A line printer however, is capable
of printing each line of data immediately as it is received.  Most dot matrix and some ink jet
printers are line printers.  Using the default printing parameters of ControLog, it could take
up to an hour to fill one page with data.
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Page Setup

Printer operation and the data sent to it can be customized with Page Setup.

a. Select Page Setup... from the File menu.  The following dialog box appears.

b. In the Select Print Items area, select the parameter to print for each of the columns.

Lines of data are printed in a column format.  The first several columns are fixed by
the system and include such things as Time, Date, Saturation Pressure, etc.  The
remaining columns of data on each page are user selectable and are shown on the
Page Setup form.  To select which data items will be sent to the printer in these later
columns, choose the item from the drop down menu which corresponds to the column
in which the data should be printed.

c. In the Select Print Type area, choose either the Full Page or Line at a Time
printing mode.

In full page mode, the system will buffer an entire page of data prior to sending it to
the printer.  When sending it to the printer, the standard Windows printer driver for
the selected printer type is used, and all printing is handled by the Windows Print
Manager.  Therefore, virtually any printer for which there is a suitable driver will
work.  Due to the pictorial nature of Windows, the graph must be sent to the printer
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using full page mode to insure proper formatting.  This is also the case when printing
any entire screen using Print Screen from the File menu.

In line at a time mode, the system bypasses the Windows Print Manager, and
communicates directly with the printer.  In this mode, each line of data is printed
immediately when available, and no data buffering is performed.  For proper
operation in this mode, the printer must be either Epson or IBM code compatible.
This includes most older dot matrix printers, and many newer printers manufactured
by Epson and Canon.  Line at a time mode is not compatible with laser printers, some
ink jet printers, and with Hewlett Packard printers operating under Hewlett Packard
Graphics Language (HPGL).  Line at a time mode requires that the printer and LPT1
printer port be dedicated solely to ControLog.  If Windows attempts to use the same
printer port when in line at a time mode, printer conflicts will result.  Line-at-a-time
mode does not function well with Windows NT due to its multi-thread buffering of
printer port data.

d. Enter the number of Data Lines Per Page.  An entry of 60 allows for one hour of
printed data per page if the data storage interval is set to one minute.

e. After all changes have been made to the Page Setup click the OK button, or click
Cancel to abort any changes.

Changing only the number of points per page will not force a new page and header to occur,
however any other changes to the Page Setup will result in a new header if printing is
currently enabled.

Selecting the Printer Port

When printing in line at a time mode, data bypasses the Windows Print Manager and is sent
directly to the LPT port.  While most computers have a parallel printer connection at LPT1,
to accommodate various computer/printer configurations ControLog can send the print data
to either LPT1, LPT2, or LPT3.  Any change made to the default setting is remembered by
the system, and therefore only needs to set once.

a. Select Communication Settings from the !  menu (left of the File menu).  The
following window appears.

b. In the Printer Port Settings area, select the Printer Port which is currently connected to
the line-at-a-time printer.  This setting will not affect any full page printing.
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c.  Click OK.  The window will close, and any line at a time printing will be directed to
the selected port.

Enabling/Disabling the Printer

Enabling and disabling of the printer is done by selecting Enable Printer from the File
menu.  When enabled, a √ appears in front of the menu item and data will be sent to the
printer on a timed interval basis (see Data Storage Interval).

When disabling the printer, an end of page command will be sent which causes the page to
eject from the printer.

What Happens When the Printer is Enabled

The printer, when properly set up and enabled, prints lines of data at user selectable time
intervals.  A header is printed at the top of each page to indicate each columns selected
parameter along with the parameter's units.  If changes are made to the Page Setup or to the
Units while the printer is enabled, the current page will eject from the printer and a new page
will be started in order to reflect the changes.  The following is a sample of the print format.

TSC Model 2500 Humidity Generator

Mode: Generate
Date: 12/17/96

Time       Sat Pres   Sat Temp   Test Pres  Test Temp  Flow Rate  %RH        Frost Pt   Dew Pt     PPM
hh:mm:ss   [psia]     [C]        [psia]     [C]        [l/min]    @PcTc      [C]        [C]        [v]
--------   --------   --------   --------   --------   --------   --------   --------   --------   --------
13:30:47              21.100                           10.00      20.00      <- Current
13:30:47   61.194     21.098     12.168     21.186     10.00      20.00      -2.354     -2.665     6.046 K
13:31:47   61.192     21.098     12.168     21.186     10.00      20.01      -2.354     -2.664     6.047 K
13:32:47   61.158     21.097     12.167     21.186     10.00      20.00      -2.348     -2.658     6.050 K
13:33:47   61.188     21.095     12.169     21.187     10.00      20.00      -2.354     -2.664     6.046 K
13:34:47   61.211     21.104     12.170     21.186     10.00      20.00      -2.350     -2.660     6.047 K
13:35:47   61.225     21.108     12.170     21.186     10.00      19.99      -2.350     -2.660     6.047 K
13:36:47   61.238     21.098     12.170     21.186     10.00      20.00      -2.360     -2.671     6.042 K
13:37:47   61.208     21.098     12.171     21.186     9.999      20.01      -2.354     -2.664     6.045 K
13:38:47   61.180     21.098     12.171     21.186     9.996      20.00      -2.349     -2.658     6.048 K
13:39:47   61.213     21.098     12.171     21.187     9.996      20.00      -2.355     -2.665     6.044 K
13:40:47   61.202     21.099     12.171     21.186     9.998      20.00      -2.352     -2.662     6.046 K
13:41:47   61.195     21.099     12.169     21.186     9.986      20.00      -2.352     -2.662     6.047 K
13:42:47   61.197     21.106     12.170     21.187     9.997      20.00      -2.351     -2.661     6.047 K
13:43:47   61.210     21.103     12.170     21.187     9.995      20.01      -2.349     -2.659     6.048 K
13:44:47   61.242     21.106     12.170     21.187     9.995      19.99      -2.358     -2.669     6.043 K
13:45:47   61.215     21.100     12.169     21.186     9.994      20.00      -2.350     -2.660     6.047 K
13:46:47   61.195     21.099     12.169     21.186     9.986      20.00      -2.352     -2.662     6.047 K

13:53:47   61.188     21.095     12.169     21.187     10.00      20.00      -2.354     -2.664     6.046 K
13:54:47   61.211     21.104     12.170     21.186     10.00      20.00      -2.350     -2.660     6.047 K
13:55:47   61.225     21.108     12.170     21.186     10.00      19.99      -2.350     -2.660     6.047 K
13:56:47   61.238     21.098     12.170     21.186     10.00      20.00      -2.360     -2.671     6.042 K
13:57:47   61.208     21.098     12.171     21.186     9.999      20.01      -2.354     -2.664     6.045 K
13:58:47   61.180     21.098     12.171     21.186     9.996      20.00      -2.349     -2.658     6.048 K
13:59:47   61.213     21.098     12.171     21.187     9.996      20.00      -2.355     -2.665     6.044 K
14:00:47   61.202     21.099     12.171     21.186     9.998      20.00      -2.352     -2.662     6.046 K
14:01:47   61.225     21.108     12.170     21.186     10.00      19.99      -2.350     -2.660     6.047 K
14:02:47   61.197     21.106     12.170     21.187     9.997      20.00      -2.351     -2.661     6.047 K
14:03:47   61.210     21.103     12.170     21.187     9.995      20.01      -2.349     -2.659     6.048 K
14:04:47   61.242     21.106     12.170     21.187     9.995      19.99      -2.358     -2.669     6.043 K
14:05:47   61.215     21.100     12.169     21.186     9.994      20.00      -2.350     -2.660     6.047 K
14:06:47   61.195     21.099     12.169     21.186     9.986      20.00      -2.352     -2.662     6.047 K
14:07:47   61.203     21.094     12.169     21.187     9.977      20.00      -2.354     -2.664     6.046 K
14:08:47   61.175     21.094     12.169     21.187     9.974      20.00      -2.352     -2.663     6.047 K

Printing Immediate Data

Selecting Print Now from the File menu causes the system to immediately send one line of
current data to the printer.  When in line at a time mode, the line of data should print
immediately.  When in page at a time, the data is sent immediately to the print buffer, but
nothing will be seen until enough data has been collected to print the entire page.
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Graphing
The Graph window is a powerful tool used to view previously generated data or to monitor
the generated data in real time using the strip chart feature.

The Tool Bar

Zoom in

Turns the pointer into a cross hair zoom tool.  Move the cross hair to the graph, then
click and drag the cursor to create a box around the portion to zoom in on.  The
portion of the graph within the drag box will expand to fill the entire graph.  The time
and Y-axis limits update accordingly.

Zoom X

Turns the pointer into a cross hair zoom tool.  Click on the graph and drag the cursor
so that the portion of the X-axis (time axis) of interest is contained within the two
vertical dashed zoom lines.  The portion contained within this region will expand to
fill the entire X-axis.  The Y-axis remains unchanged.
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Zoom Y

Turns the pointer into a cross hair zoom tool.  Click on the graph and drag the cursor
so that the portion of the Y-axis of interest is contained within the two horizontal
dashed zoom lines.  The portion contained within this region will expand to fill the
entire Y-axis.  The X-axis remains unchanged.

Fit X

Adjusts the left and right limits of the time axis to match the beginning and ending
points of the stored data.  This allows the parameters being graphed to fit within the
left and right limits of the graph window.  The X limits update accordingly.

Fit Y

Rescales the Y-axis in order to make the graphed data fit within the graph window.
The Y limits update accordingly.  The X-axis remains unchanged.

Current X

Shifts the graph so that right edge of the graph to the ending data point.  The time
span remains fixed.

Shrink to Fit

Adjusts the left, right, top and bottom limits on the graph axes so that entire data set
of each selected items is contained with in the boundaries of the graph.

Copy Graph

Copies the current graph picture to the clipboard in a metafile format.  This picture
may then be pasted into another program.

Print Graph

Causes the graph to maximize and a page size picture of the current graph to be sent
to the printer.  Once the graph has been sent to the printer the graph window returns to
its previous size.  This item is only available when using the full page print mode.
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The Graph Menu

New Graph

Select  New Graph... from the Graph menu.  A dialog box with a scrolling list of all
available data will appear.  The currently selected graph items will be highlighted.

Select the items to be graphed, then click on the OK button.  The graph will update to
reflect the changes.  The source of the graph data is the tabular data window.
Selecting the Cancel button will terminate the new graph operation and no changes
will occur.

Time Span

Select Time Span... from the Graph menu.  A dialog box appears asking you to enter
a new X-axis time span.  The X-axis is updated by maintaining the right time limit
and adjusting the left time limit to reflect the specified time span.

Shrink to Fit

Selecting Shrink to fit from the Graph menu adjusts the left, right, top and bottom
limits on the graph axes so that entire data set of each selected items is contained
within the boundaries of the graph.

Edit Axis Limits

Selecting Edit Axis Limits... from the Graph menu, or double clicking directly on the
graph itself, causes the following input box to appear.
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Both the minimum and maximum limits for the X and Y axes may be changed.
Another feature of the Edit Axis input box is the ability to set a mid point and span
value for the Y axis.

Enable Strip Chart

When the strip chart is enabled, the rightmost time limit reflects the time of the last
stored data point, while the leftmost time limit adjusts accordingly to keep a constant
time span.  Each time data is stored, the strip chart is updated

Selecting Enable Strip Chart from the Graph menu enables and disables the strip
chart feature of ControLog.  When enabled, a √ appears in front of the menu item and
the graph begins updating at regular time intervals (see Data Storage Interval).

Graph Title

Select Graph Title... from the Graph menu to add or change a graph title.  Enter the
desired graph title into the dialog box that appears.  Click OK.

Y-axis Title

Select Y-Axis Title... from the Graph menu to change the y-axis title.  Enter the new
title in the dialog box that appears.  Click OK.

Show Legend

Selecting Show Legend from the Graph menu causes a legend to appear on the
graph window.   A √ appears in front of the menu item.

To hide the graph legend, select √ Show Legend from the Graph menu.

Edit Legend

Select Edit Legend... from the Graph menu.  A dialog box appears, asking you to
rename legend item 1.  The current default name is already entered and highlighted.
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If you want to change the name, simply type in the new one.  Select OK to update the
change and/or go to the next legend item.  You will be asked to accept or change each
graph legend item.  Select Cancel to exit the edit routine without making any changes.

Show Grid

Selecting Show Grid form the Graph menu places a grid on the currently graphed
data to help clarify data values.  A √ appears in front of the menu item.

To remove the grid, select √ Show Grid from the Graph menu.

Show Markers

Select Show Markers from the Graph menu to place marker symbols at each of the
individual data points plotted.  A √ appears in front of the menu item.

Select √ Show Markers from the Graph menu to remove the markers.

Print Graph

The Print Graph menu item responds exactly like the Print Graph button on the
Graph window's toolbar.  The printer must be in the full page mode in order for the
graph to print properly.  During this operation the Graph window will maximize,
redraw, print, then return to normal size.

Graph Data

The graph works hand in hand with the tabular data window.  While the generator is in
operation, the tabular data window stores the most recent one thousand data points.  If the
data exceeds the maximum number of data points allowable, the data is still stored to the
same temporary data file (\sysfiles\sys.dat) but only the most recent data is available to the
graph.  Additional information about the graph data is provided in Data Storage & Retrieval.
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7

Reports
ControLog can create custom reports containing generator and user supplied data for
individual instruments.  Data may be collected for as few or as many points as desired.  Data
collected is placed into a set of temporary files for later use by the Report Editor.  Data is
written into these temporary files in the following format.

              Gen  Temp  ----2500 Data----  ---Instr Data----  ----Correction---
  Date/Time   Mode Unit    Hum      Temp      Hum      Temp      Hum      Temp
------------- ---- ----  -------- --------  -------- --------  -------- --------
06Feb96 12:48 %RH  C     90.01    21.005    90.27    21.062    -.27     -.062
06Feb96 13:25 %RH  C     84.99    21.010    85.35    21.050    -.35     -.050
06Feb96 13:52 %RH  C     70.00    21.009    70.24    21.045    -.24     -.045

Each data entry into a temporary file is time and date stamped, and includes the generated
humidity mode and temperature units.  The corresponding instantaneous values of the
generated humidity and temperature are included along with the humidity and temperature
that you enter for the instrument under test.  Also included are calculated correction values
which are computed as the difference between the generated values and those entered for the
test instrument.  There is a separate temporary file created for each of the eight test
instruments in the c:\tsc2500\sysfiles\ directory.

Clearing Report Data (when used without the 9800 Data Acquisition System)

To start collecting data to a new temporary report data storage file, it is necessary to clear the
current temporary data storage file or restart ControLog.  If the data files are not cleared, the
new data will simply append to the existing data in the file.  (Clearing is automatic when
ControLog is used with the 9800 Data Acquisition System.)

a. Select Clear Report Data... from the Reports menu.  The following dialog box will
appear.

b. Select the desired range for the data files to clear and click OK.
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Collecting Report Data (when used without the 9800 Data Acquisition System)

a. Assure both the generator and test instruments are stable at the desired point.

b. Select Save Data Point Now... from the Reports menu.  In the dialog box that
appears, the current generated humidity and temperature have already been supplied.

c. Click on the data entry field which corresponds to the instrument data you wish to
supply.  Enter the data, taking note of both the humidity mode and units.
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d. Once you have entered all of your data for each of the instruments, Click OK.  Data
will be appended to a temporary data file for each of the selected instruments.

e. Repeat steps c and d at each humidity/temperature point that requires instrument data
to be entered.

f. When the run is complete and all of the test instrument data has been collected, use
the Report Editor to edit, print, and save the instrument reports (see The Report
Editor).

Collecting Report Data (when used with the 9800 Data Acquisition System)

When used with the 9800 Data Acquisition System, Report Data is automatically collected
prior to each setpoint change.  To save data in addition to that which is automatically
collected, select Save Data Point Now... from the Reports menu.  The current data for
each channel is stored to files for each of the active channels.  For a discussion of Data
Acquisition functions, including channel activation, see Data Acquisition.

The Report Editor

The Report Editor allows for customized report generation showing test instrument
performance data.  Once the data has been collected (see Collecting Report Data), the Report
Editor is used to preview, edit, print, and save completed reports for each test instrument.

Creating, Printing, and Saving a Report

Each report consists of a Header, Test Information, Data, and a Footer section.  Each of these
elements are editable prior to printing and/or saving the report.  The Header, Test
Information, and Footer sections are completely customizable and may be saved in their
customized forms for later recall and inclusion in future reports.
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a. Since this procedure involves sharing the use of the printer with other portions of
ControLog, ensure that the Page at a Time printing mode is selected (see Page Setup).

b. Select Report Editor... from the Reports menu.  The Report Editor appears.

c. Select Header from the View menu.  Load, edit, or save the header information as
needed (see Editing the Header).

d. Select Footer from the View menu.  Load, edit, or save the footer information as
needed (see Editing the Footer).

e. Select Test Information from the View menu.  Load, edit, or save the test
information as needed (see Editing the Test Information).

f. Select Data from the View menu to bring up the data screen.

g. From the Report for Instrument: box at the bottom of the screen, select an
instrument number.  The previously collected data for the selected instrument appears
on the screen.

h. Edit the data if needed (see Editing the Data).

i. Click Print Report to print a report for the instrument selected using all of the
information (header, footer, data, etc.) as currently edited.

j. Click Save Report to save the report to a text file.  A dialog box appears asking for
the destination path and filename.  By default, the reports will be stored in the \rptfiles
directory.  The recommended file extension is .rpt.

k. Enter a valid filename and click OK, or click Cancel to abort the file save process.
Saved reports are stored as standard text files and may be imported into a word
processor or text editor program for viewing or further editing at a later date.
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l. Repeat steps c through k as needed for each of the instruments requiring reports.

Editing the Header

The report header is printed at the top of each report and should contain fixed information
such as Company Name, Address, etc.  Several report headers may be created and saved for
use with different types of report styles.  For example, a different header would most likely
be used when printing a report on letterhead rather than on plain paper.  The header
information on the screen at the time of printing or saving a report is the information that is
used for that report.

a. If not already in the Report Editor, select Report Editor... from the Reports menu.

b. If the Header window is not visible, select Header from the Report Editor's View
menu.

c. Using normal text editing procedures, edit the header text as needed.  Add blank lines
(using the Return key) at the top of the header to shift the entire report downward as
needed.  The header can be centered visually using spaces to the left of each line.

Saving a Report Header

a. Once edited, save the header for later recall by selecting Header... from the Save sub
menu of the Report Editor's File menu.

b. From the dialog box that appears, enter an appropriate header filename.  Use a .hdr
suffix when naming header files.  This makes it easier to distinguish them from other
types of files when recalling them later.

Recalling a Previously Stored Report Header
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a. Select Header... from the Open sub menu of the Report Editor's File menu.  A list of
any previously created header files is displayed (files with a .hdr suffix).

b. Select a header file from the list, or enter a valid filename in the dialog box that
appears.  Click OK to load the header selected, or click Cancel to abort the load
process and retain the current header information.

Saving a Default Report Header

To make a header the default, create the report header and save it as
\sysfiles\header.hdr.

Editing the Footer

The report footer is printed at the bottom of each report and should contain fixed information
such as technician name, signature and date lines, etc.  Several report footers may be created
and saved for use by different technicians.  The footer information on the screen at the time
of printing or saving a report is the information that is used for that report.

a. If not already in the Report Editor, select Report Editor... from the Reports menu.

b. If the Footer window is not visible, select Footer from the Report Editor's View
menu.

c. Using normal text editing procedures, edit the footer text as needed.
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Saving a Report Footer

a. Once edited, save the footer for later recall by selecting Footer... from the Save sub
menu of the Report Editor's File menu.

b. From the dialog box that appears, enter an appropriate footer filename.  Use a .ftr
suffix when naming footer files.  This makes it easier to distinguish them from other
types of files when recalling them later.

Recalling a Previously Stored Report Footer

a. Select Footer... from the Open sub menu of the Report Editor's File menu.  A list of
any previously created footer files is displayed (files with a .ftr suffix).

b. Select a footer file from the list, or enter a valid filename in the dialog box that
appears.  Click OK to load the footer selected, or click Cancel to abort the load
process and retain the current footer information.

Saving a Default Report Footer

To make a footer the default, create the report footer and save it as \sysfiles\footer.ftr.

Editing the Test Information

The test information is printed immediately after the header of each report and should contain
fixed information such as serial number, model number, etc. specific to the instrument under
test.  Since test information is device specific, several test information files may be created
and stored for later recall.  The test information on the screen at the time of printing or saving
is the information that is used for that report.

a. If not already in the Report Editor, select Report Editor... from the Reports menu.

b. If the Test Information window is not visible, select Test Information from the
Report Editor's View menu.  The Test Information window appears.
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c. Using normal text editing procedures, edit the remarks area of the test information
section as needed.

d. Using normal data entry procedures, edit any or all fixed data items such as Serial
Number, Model Number, etc.  If an entry is left blank, then neither the title or the
entry will appear on the report.

e. To change the titles of the fixed data items, hold the Ctrl key and click directly on the
title itself.  You will be prompted for a new title for that item.

Saving the Test Information

a. Once edited, save the test information for later recall by selecting Test
Information... from the Save sub menu of the Report Editor's File menu..

c. From the dialog box that appears, enter an appropriate Test Information filename.
Use a .msc suffix when naming test information files.  This makes it easier to
distinguish them from other types of files when recalling them later.

Recalling Previously Stored Test Information

a. Select Test Information... from the Open sub menu of the Report Editor's File
menu.  A list of any previously created test information files is displayed (files with a
.msc suffix).

b. Select a test information file from the list, or enter a valid filename in the dialog box
that appears.  Click OK to load the test information selected, or click Cancel to abort
the load process and retain the current test information.
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Saving the Default Test Information

To make the current test information the default, create the report footer and save it as
\sysfiles\misc.msc.

Editing the Data

The report data is printed immediately following the test information and contains previously
collected data for the specified instrument.  Prior to printing or saving the report, the data
may be viewed and edited.  The data as it is on the screen at the time of printing or saving a
report is the data that is used for that report.

Selecting the Test Instrument Data

a. If not already in the Report Editor, select Report Editor... from the Reports menu.

b. If the Data window is not visible, select Data from the Report Editor's View menu.
The Data window appears.

c. From the Report for Instrument: box at the bottom of the screen, select an
instrument number.  The previously stored data for the selected instrument appears on
the screen.

Prior to printing or saving, the data text may be edited as needed using normal text
editing procedures.
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Alternate Report Generation

In addition to the report files already discussed, use of the 9800 Data Acquisition
automatically provides for an alternate data storage.  This file is named with a time/date
stamp stored in the /datfiles directory.  One file is written for each run, and contains one entry
per channel for each setpoint, in addition to the corresponding humidity and temperature
generated at each of these points.  The data is stored in a consistent format, with descriptive
headers, and fixed columns.  This file is written at the completion of each run and is named
with a 14 character time stamp filename of the form yyyymmddhhmmss containing the year,
month, day, hour, minute, and second the file was created.  This results in a unique file name
for each individual run.  This file may be used in your own custom report generation
program.  Custom Report Generation programs can be written using third party tools such as
Excel, Visual Basic, and others.
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8

Auto Profiling
The Auto Profiling mode of operation is very similar to the Generate mode with the main
exception that profiling relies on a predefined list of referred to as a profile.  The user
configurable profile is used as ControLog's road map during Auto Profile operation.  It
defines which setpoint values to go to, at what rate to go from one setpoint to another, and
how long to stay at a specific setpoint before moving to the next one.

Note- Before attempting to operate the system in an Auto Profile mode, you
should become thoroughly familiar with the Generate mode of
operation.

It is assumed in this section that either the 9800 Data Acquisition System has already been
configured (see Data Acquisition) or it was OFF while ControLog was started.

Creating a Profile

A profile is a list of humidity, temperature, pressure, flow, and time parameters that are used
during automated control of the 2500 generator.  The profile essentially programs the
computer/controller operations.

Prior to operating in the Auto Profile mode, a profile must be created, or a previously created
profile must be recalled from disk.  In either case, a profile must currently be loaded into
ControLog and be visible on the Profile window.

Creating a profile consists of several steps:

•  Showing the Profile window

•  Clearing any existing profile if desired

•  Selecting the mode of humidity control

•  Selecting units for temperature, pressure, flow, etc.

•  Entering the profile data

•  Editing assurance conditions

•  Enabling/disabling historical information
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Show the Profile Window

a. Select Profile from the Window menu.  The Profile window appears.

The first column, next to the point numbers, contains values of humidity to generate
and is titled at the top according to the currently selected profile humidity control
mode.  In the example shown, the profile humidity control mode is set to %RH @Pc.
Whenever the profile humidity control mode is changed, the title on this column
changes to reflect the mode selected.

The Saturation Temp column contains the saturation temperature setpoint and should
be set to the desired test temperature.  Temperature values are entered and displayed
in the currently selected profile units.

The Flow Rate column contains values of system air flow at which the generator will
operate.  Although not affecting the generated value of humidity, flow rate does affect
the air exchange rate within the test chamber and the equilibration time of any
instruments under test.

Ramp Time is the desired amount of time that the 2500 should take to transition from
one profile test point to another.  Setting a ramp time of 0 (zero) instructs the 2500 to
make the transition as quickly as possible.  0 (zero) is the setting used for most
applications.

Soak Time is the desired amount of time to generate at a particular profile point.  The
soak time required depends on the application, but should be at least 10 to 15 minutes,
depending upon the humidity measurement devices being calibrated.

Assured Soak, if set to Y, forces the system to wait until measured values are within a
specified tolerance and stability before the computer starts the Soak Phase.  If N is set,
the Soak Phase will start immediately upon completion of the Ramp Phase.
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Clear old Profile Data

b. Select New Profile... from the Profile menu. While this is not a requirement,
clearing the old profile data allows you to start with a blank profile window.

Set the Profile Humidity Mode

c. From the Profile menu, select Mode.

d. From the Mode submenu, select the desired profile humidity control mode.

Upon selection, the new mode caption with its units will appear as the title of the
profile window's humidity value column.  The data in the humidity value column will
be cleared if the new mode is not similar to the old profile mode (such as when
changing from Frost Point to PPMv).

Set the Profile Units

e. From the Profile menu, select Units.

f. From the Units submenu, select the unit type to change, and finally the actual units
desired.

The profile units are for use in entering the profile only and affect nothing else but the
profile window (note the units indicators in the profile window's column headings).
Setting the profile units will not change the systems units.  If you want the systems
units to be the same as the profile's, you must change them separately.

Enter the Profile Data

g. Click once on the cell of any value needing change.  It is usually best to start at the
upper leftmost cell.

h. Edit the value, then press either the Return or Enter key, or click on the checkmark
button at the upper left area of the profile window. (Clicking the X button cancels the
entry, leaving the value unchanged.)

i. Enter all required values of humidity, temperature, pressure, flow, ramp time, soak
time, and either a "Y" or "N" for assured soak.  Pressing Return, Enter, or clicking the
checkmark button after each entered value advances the cursor to the next parameter.

j. Enter all remaining profile lines in the same manner.  To make corrections to an
existing profile item, simply select and edit the data for that cell.

As the points are entered, the computer will predict the next value based on previous
points entered.  If these predictions are not correct simply enter the correct value
desired.

Each Profile entry is validated at time of entry as you are moving across the profile
line.  This validation is to assure that each entry is within system tolerances.
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When moving from one line to another, the entire line is validated with respect to all
other items contained on that profile line.  Any invalid entry will cause a message box
to appear and the value that may be causing the problem to be hilighted.

While an item that is left empty is a valid entry choice, all items on the line must be
completed in order for the line to used.  When the system is operating in Auto Profile
mode, the first line encountered with a missing entry is considered the end of the
profile, causing the system to shut down when that line is reached.

Set the Assurance Conditions

Assurance conditions are user specified tolerances between setpoint and measured
values.  If assured soak is to be used (any "Y" in the assured soak column), then these
tolerances must be met during the Assurance Phase before the Soak Phase begins.

k. Select Assurance Conditions... from the Profile menu.  The following dialog box
appears.

l. Edit the values of Tolerance and Std Dev as required.  For quicker Assurance times,
increase the Tolerance and/or the Std Dev values.  Tighter tolerances or standard
deviations (smaller values) result in longer Assurance times.  Setting these values too
small could prevent assurance conditions from being met, therefore preventing the
system from advancing to the next profile point.  Although all parameters may be
edited, only the humidity parameter of the currently selected control mode and the
lower system parameter tolerance values will affect assurance conditions.

A tolerance or standard deviation value left blank will always meet the assurance
conditions.

m. Click OK to accept the assurance conditions as entered and close the window.
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Enable/Disable Historical Data

The historical data feature of the profile allows you to retain a record of the
generator's performance for long term comparison or repeatability analysis.  When
historical data is enabled, each point of a given profile will maintain a separate data
file of the soak phase data collected for that point during the profile run.  The data
files have the same name as the profile itself, but the first point will have the suffix
.001, the second point will have the suffix .002, etc.  Each time this same profile is
run, the new soak data is appended to the existing data in the appropriate historical
files.  These files are located in the same place as the original profile which is usually
the \profiles directory.

n. Selecting Append to Historical Files from the Profile menu enables and disables
the historical data feature.  When enabled, a √ appears in front of the menu item.

After completing all of the steps in the profile entry process, the profile is ready to be used to
control the operation of the 2500.  There is no requirement for the profile to be saved to disk
in order to be used.  However, you will find that a given profile is often times run more than
once.  It is to your advantage to save it so that you don't have to re-create it each time.

Saving a Profile

Once a profile is properly entered, the assurance conditions set, and the historical data
decision made, it may be save to disk for later retrieval.  Profiles are normally saved to the
\profiles directory and it is recommended that an extension of .prf be used.

a. Save a profile to disk by selecting Save Profile... from the Profile menu.

b. In the dialog box that appears, supply a valid path and filename, then click OK.

Once saved, the Profile window title will indicate the new profile name.  The existence of a
profile path name on the Profile window title bar is an indication that the profile currently in
memory matches the profile of the same name stored on disk.

A profile window that is titled Profile: Untitled indicates that either the profile has not yet
been saved, or has been altered after loading.  This occurs if the profile points are edited after
being saved.  Profiles are saved with all attributes such as control mode, units, assurance
conditions, historical data mode, etc.  Changing assurance conditions or historical data mode
after loading does not affect the profile window title.

Saving a Profile as the Default

To make a specific profile the default, which loads automatically at power-up, save it as
\sysfiles\profile.prf.   
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Loading an Existing Profile

a. To retrieve a previously saved profile from disk, select Open Profile... from the
Profile menu.

b. In the dialog box that appears, choose an existing profile filename, then click OK.

When opened, the profile is verified and then loaded into memory.  The previous profile is
cleared from memory and the new profile is loaded with all the attributes that it was saved
with, including units, assurance conditions, and historical data mode.

Printing a Profile

To print a copy of the profile in memory, select Print Profile from the Profile menu.  It is
best to save the profile to disk before printing so that the profile name will also be printed.

Starting Auto Profile

a. Check the Profile window to assure the profile you want to run exists in the system
memory.

b. If profile uses assurance conditions, verify assurance conditions are correctly
specified.

c. Select Auto Profile from the Run menu.

d. Select the starting point from those listed in the dialog box, then click OK.

The selected starting point will be entered into the appropriate setpoint fields of the Control
Parameters window and the generator will start-up in the same fashion as a normal Generate
mode.  While operating the system in the Auto Profile mode, setpoint changes in the Control
Parameters window are not allowed. Also, if changes are made with the 2500 keypad
directly, they will quickly be overridden by ControLog.
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You may, however, make changes to the profile itself while it is executing.  Changes made to
any points beyond the currently executing one will be effective.  But changes made to the
current point or any prior ones are ignored.

To see which point and phase is being executed, use the System Timing window.

Stopping Auto Profile

A Shutdown may be performed at any time during a profile but will automatically occur
when the last soak phase has been completed.

Another way to exit the Auto Profile is to switch from Auto Profile to Generate.  The current
setpoints for Saturation Pressure, Saturation Temperature and Flow are used to continue
control of the system in Generate mode.

Understanding Phase and Point

Each profile point consists of three distinct phases; Ramp, Assurance and Soak.  Each phase
accomplishes a specified task.

The Ramp phase is used to linearly transition from one point' to the next point' in a given
amount of time.

The Assurance phase forces the system to wait until measured parameters and setpoint values
are within a specified tolerance and stability before the computer starts the Soak Phase.

The Soak phase is the desired amount of time to generate the particular profile point before
proceeding to the next point.

Examples of Ramp/Soak/Assured Soak Phase combinations:

Example 1: Ramp Time Soak Time Assured Soak
0 1 N

Example 1 causes the Soak phase to begin immediately at the start of the profile point, even
though the 2500 may still be adjusting to the point.  The next point will start after the 1 hour
soak phase.

Example 2: Ramp Time Soak Time Assured Soak
0 1 Y

Example 2 causes the Assurance phase to begin immediately at the start of the profile point.
The measured values are continually compared with the setpoint values until they agree to
within a set tolerance and the measured values are stable to within the specified degree.  Once
assured (tolerances met) the Soak phase begins.  Total time required for this point is variable
and depends upon the amount of time that is required for assurance (dictated by tolerances).
Total time for example 2 is elapsed assurance time plus 1 hour.

Example 3: Ramp Time Soak Time Assured Soak
.5 1 Y



62 Auto Profiling

The Ramp phase (Ramp Timer) begins at the start of the point.  The system adjusts slowly
toward the setpoint, taking 30 minutes.  Once the Ramp Time has elapsed, Assurance starts
and waits for tolerances to be met.  When tolerances are met, the Soak phase begins and last
1 hour.  Total time for example 3 is 30 minutes, plus elapsed Assurance time, plus 1 hour.
Assurance time is a variable and depends on tolerances.

Manual Override of Profile

Although the system is operating automatically, some manual control is allowed using the
Hold Point, Next Phase and Next Point menu items on the Run menu.

Holding the Profile

Selecting Hold Point from the Run menu stops the current "Remaining Time" timers,
allowing the system to remain indefinitely at the current point.  While in a hold mode, the
system is prevented from completing the ramp, assurance, or soak phases or a point.  When
holding, a √ appears in front of the menu item and hold indicator appears in the System
Timing window.

To resume the profile point select the menu item again.  This re-enables the timing functions
and allows the profile to resume normal operation.

Advancing to the Next Phase

Selecting Next Phase from the R u n menu manually duplicates the action which
automatically occurs when a Remaining Ramp or Soak Time counter reaches 0 (zero), or
when the assurance conditions are met.  In other words, it causes Ramp Phase to proceed to
the Assurance or Soak Phase, Assurance to proceed to Soak, or Soak to proceed to Ramp of
the next profile point.  This allows for early manual termination of any phase within a profile
point.

Advancing to the Next Point

Selecting Next Point from the Run menu manually duplicates the action which automatically
occurs when the Point time counter reaches 0 (zero).

Auto Profiling with Data Acquisition

If ControLog recognizes that the 9800 Data Acquisition System is connected and powered
on, the Auto Profile mode cannot be enabled until after the Data Acquisition System has been
configured.  See Data Acquisition.

When used with the 9800 Data Acquisition System, data is automatically sampled and stored
for each active channel to the time/date stamped file in the \datfiles directory.  One line entry
is made to the file for each setpoint executed.  Data is stored at the end of each point just
prior to the start of the next point (or completion of the profile if on the last point).
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9

Data Acquisition
When used with the 9800 Data Acquisition System, ControLog has the ability to measure and
record data for up to 30 channel-pairs of humidity and temperature.  The raw signals can be
voltage, current, or resistance (either 2 or 4 wire).  It can scale the raw measured data to
humidity and temperature units, and can then use this data to compute an alternate humidity
expression.  For example, if a channel is configured to measure the dewpoint from a chilled
mirror hygrometer, this dewpoint can then be used to automatically compute %RH.

In addition to the 30 channel-pairs of temperature and humidity, there are also 30 channels of
auxiliary temperature measurement which are coupled with the humidity/temperature
channels.  These auxiliary temperatures, when their probes are placed in close physical
proximity to the humidity measurement device of their corresponding humidity/temperature
channel, can be used to automatically correct the measured humidity for temperature
differences between them and the 2500's chamber temperature sensor.  This is most useful
when working with Relative Humidity.  RH is dependent upon temperature, meaning that a
temperature gradient in the chamber of the 2500 will result in a corresponding RH gradient as
well.  By using the auxiliary temperature probes, one mounted in close physical proximity to
each of the humidity measurement probes, the temperature gradients, and thus the RH
gradients, can automatically be accounted for.

9800 Data Acquisition System
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Setting up for Data Acquisition

When the ControLog program is launched, it looks for the presence of the 9800 as one of its
initialization sequences.  It queries the HP34970A meters within the 9800 looking for an
expected response.  If it finds that both meters are connected and responding properly, it
loads the remainder of the code required to utilize them.  If for some reason the HP34970A
meters do not respond properly (power off, improper communication settings, etc.) then the
Data Acquisition section of ControLog is completely removed, and operation reverts to that
of standard ControLog.  So what this means is that prior to launching ControLog, ensure that
the HP34970A meters are turned on and that their communication interfaces are properly
configured.



Data Acquisition 65

HP34970A Communication Interface

The HP34970A meters are connected to ControLog via RS-232 communication.  As shipped
from the factory, communication parameter defaults for ControLog are set to COM3 for the
left HP34970A, and COM4 for the right one.  Both communicate with the following
parameters:

Baud Rate: 9600
Data Bits: 8
Parity: N
Stop Bits: 1
Handshaking: RTS/CTS

The HP34970A meters will have been set up prior to shipment from the factory.  If for some
reason you need to view or change these parameters, please refer to the applicable HP
instruction manual.  However, here is an abbreviated set of instructions:

Press Shift then Interface on the HP front panel.  The display should show
either HPIB or RS-232.
Using the dial knob, select RS-232.

Press Interface again.  The baud rate should appear.
Using the dial knob, select 9600 BAUD.

Press Interface again.  The data bits, parity, and stop bits should appear.
Use the dial knob to set these parameters to NONE, 8 BITS.

Press Interface again.  The handshaking parameters appear.
Use the dial knob to set the handshaking to FLOW RTS/CTS.

Press Interface again to finish setting up the communications, causing the HP to accept the
changes.

Ensure that the RS-232 cables are properly connected.  The left HP (as viewed from the
front) must connect to the computers COM3 port.  The right HP (as viewed from the front)
connects to the computers COM4 port.
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Ensuring the 9800 Detection

If the Data Acquisition System was detected properly while ControLog was launching, then
two new items, Channel Monitor and Data Acquisition, appear at the bottom of the Window
menu.  When these two items are there, ControLog has successfully identified the HP34970A
meters, both serial ports are properly connected, and the communication parameters are most
likely correct.

If Channel Monitor and Data Acquisition do not appear at the bottom of the Window menu,
then one or both of the HP34970A meters was not properly detected.  In this case, ControLog
reverts to its standard mode of operation and makes no further attempt to communicate with
the data acquisition system until it is exited and re-launched.  In this way, ControLog will
still launch and run normally on non-9800 systems.

The following things can cause ControLog to fail in its attempt to detect the 9800:

• One or both of the HP34970A meters not powered on,
• One or more of the three plug in cards (HP34901A 20-channel multiplexer) in each

HP34970A incorrect or missing,
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• RS-232 cables not connected,
• RS-232 cables connected to the wrong COM ports,
• RS-232 parameter mismatch between the computer and either HP34970A.

If this problem is encountered, see The HP34970A Communication Interface.

Hardware Connection of Instruments

The 9800 can connect to a variety of instrument types with a variety of output options
including voltage, current, resistance, and temperature detectors.  The HP34970A meters that
make the actual measurements are connected to the front panel of the 9800 in channel-pairs
of 2 wires each.  This means that there are 4 wires per channel pair.  For the left side of the
connector/interface panel, there are two wires for humidity measurement, and 2 wires for
temperature measurement.  On the right side of the connector/interface panel, there are 4
wires for resistance (or temperature) measurement of an auxiliary temperature probe.  All
measurement channels of the HP34970A have fully floating, differential inputs.   Both panels
also have a power and ground signal for powering transducers directly if desired.  Depending
upon the specific 9800 system, the power will either be 24 VDC single ended, or a bipolar
(plus and minus) variable power supply connection along with a ground connection.  On this
later system, there are 3 wires used for power.  These connections are brought to the pins of
the DB-9 connectors with the following pinout:

1

2

3

4

6

7

8

9
5GND

+ H signal
– H signal
+ T signal
– T signal

+24 VDC
GND

GND

GND

The latter system discussed has a slightly different pinout for the power connections:

–VDC

+ H signal
– H signal
+ T signal
– T signal

+24 VDC
1

2

3

4

6

7

8

9
5

N/C

GND
N/C

(variable)

(variable)

Specific personality modules are then used to make the appropriate connections between the
instruments under test (or the auxiliary temperature probes) and the data panel.  The
transition is also made in the personality modules for grounding of the appropriate signal
lines in the case of single ended instrument outputs, since the HP34970A has differential
inputs.  It is also in the personality modules that the power supply connections to the
instrument are properly routed.  When needed, a module with a current dropping resistor is
used to properly convert a loop current to a voltage in order to be measured.  The value of
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this dropping resistor is stored in the sysfiles\daux.ini file and is used to mathematically
determine the value of the current that produced the voltage measured (see The Daux.ini file).

There are several different personality modules, each terminating for user connection into an
RJ-45 or RJ-11 connector for quick connection/disconnection and easy replacement.  For
details of the specific modules available, or for a determination of the exact modules needed
for your application, please consult the factory.

System Configuration

Prior to collecting data, and prior to generating, the Data Acquisition System must first be
configured.  This is done through the Data Acquisition window.  To bring up the Data
Acquisition window, select Data Acquisition from the Window menu.  The following window
appears.

The System Config tab in the Data Acquisition window shows parameters and options which
affect the way ControLog and the Data Acquisition system communicate, the method used to
compute auxiliary humidity parameters, and some options regarding measuring, averaging,
and viewing of data.

DA1 and DA2 Communications

The DA1 and DA2 Communications sections are used to set the communications parameters
of the computer so it will match those of the left and right HP34970A meters respectively.
These selection boxes are generally locked out so that changes can not be made.  When
unlocked (see Allow Configuration Editing), changes can be made to the various parameters
that can then be tested with the Test button.  The Test button sends a message request to the
HP34970A for its ID name.  The response from the HP34970A, if any, is displayed in a small
window.
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Regardless of the selected parameters, ControLog always reverts back to a set of default
parameters each time it is launched.  These default parameters are stored within an ini file.
The only way to permanently change the defaults that ControLog launches with is to change
the parameters in this ini file.  For further discussion of the ini file parameters, see The
Daux.ini File.

Auxiliary Humidity Computations

In addition to measuring humidity and temperature from connected devices, ControLog can
compute an alternate humidity parameter (Relative Humidity, Dew Point, or Frost Point) to
display alongside the measured humidity value. For instance, if your device measures
Relative Humidity, but you want to also compute the Dew Point, you can do automatically by
properly setting the Auxiliary Humidity Computations.  Or, if your device measures Relative
Humidity, and you want it to be compensated for temperature gradients, this is possible also.
Any one of the following parameters may be selected in any possible combination:

Compute Auxiliary using and
Relative Humidity 2500 Humidity 2500 Chamber Temperature
Dew Point Instrument Humidity Instrument Temperature
Frost Point Auxiliary Temperature

The only requirement is that there be a defined Compute parameter, and that the sources of
humidity and temperature data be defined.  ControLog takes care of the various units
conversions that may be required to accomplish the selected computation.  The auxiliary
humidity that is computed, along with the measured instrument and auxiliary temperature
data, will appear in columns in the Instrument Data tab.

The Auxiliary Humidity Computation area is normally locked out, and must be unlocked in
order to make changes.  See Allow Configuration Editing to unlock the Auxiliary Humidity
Configuration area.  Any changes you make will only be temporary. Regardless of the
selected parameters, ControLog always reverts back to a set of default parameters each time
it is launched.  These default parameters are stored within an ini file.  The only way to
permanently change the defaults that ControLog launches with is to change the parameters in
this ini file.  For further discussion of the ini file parameters, see The Daux.ini File.

Options

There are a few options which allow you to modify the way that ControLog shows
configuration and instrument data, how often it scans the data, and how it averages.  Any
changes you make to these options will only be temporary. Regardless of the selected
options, ControLog always reverts back to a set of default options each time it is launched.
These default options are stored within an ini file.  The only way to permanently change the
options that ControLog launches with is to change the parameters in this ini file.  For further
discussion of the ini file parameters, see The Daux.ini File.

Enable Data Acquisition

This option allows you to turn off the data acquisition system so you can run
ControLog without requiring measurements to be taken from instruments.  This
option is normally left ON and is generally used only when troubleshooting a problem
between ControLog and the Data Acquisition System.



70 Data Acquisition

Append Units to Inst Data

This option, when selected, appends units to the measured data which is shown in the
Instrument Data tab.  If copying and pasting the data from the Instrument Data tab
and using it in other programs, like spreadsheets for example, you may want to de-
select this unit's option.  Some other programs require numeric value only and cannot
properly deal with the appended units.  ControLog handles the data properly either
way.  If the data is not being copied and pasted into any other application, then the
choice about appending units to the data is one based solely on personal preference of
the current user.

Show Raw Signal Data

When selected, the Instrument Data tab now only shows the scaled instrument
humidity and temperature data, it also shows the raw voltage, current, or resistance
data it measured for the particular channel.  Selection of this option is based solely on
the personal preferences of the current user.

Allow Configuration Editing

When de-selected (default), no configuration changes can be made within the System
Configuration (except these options), within the Instrument Configuration tab (except
to enable/disable a channel), or within the Temperature Configuration tab.  This
prevents things from inadvertently being changed.

When attempting to select this option, a password is required.  Without the proper
password, this option may not be selected.  There are two levels of password
protection.

The lowest password level allows for user configuration within the Instrument Config
and Temperature Config tabs in order to define measurement type, scaling factors,
units, etc.

The highest level password allows the same possibilities as the lowest level, but
additionally allows for editing of the parameters within the System Config tab.

Specify Instrument Gain and Offset

Scaling of the raw instrument data into usable humidity and/or temperature values
may be done in either of two ways.  Assume that the signal output from a particular
sensor is 4 to 20 mA, and that represents 0 to 100% RH.  One way to configure the
channel for this data scaling is to specify (enter in) the low and high raw values (4,
20) and the low and high scaled values (0,100).  ControLog then internally computes
the gain and offset needed (in this case 6.25 and ñ25 respectively) to perform the
required scaling.

The other way to configure the system for the scaling requirement is to specify the
gain and offset values directly.  As with the example above, the values to enter would
be 6.25 and ñ25.  What this means is that the raw signal is to be multiplied by 6.25,
then ñ25 is to added to it.  For example, 4 mA, when multiplied by 6.25 and added to
ñ25, results in a value of 0.  And 20 mA, when multiplied by 6.25 and added to ñ25,
results in a value of 100.

The column heading within the Instrument Config tab change to reflect the method
selected for specifying the scaling parameters.
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Scan Rate

The scan rate is the number of seconds to wait between scans of the data acquisition
system.  Allowable values are from 1 to 60 seconds.  The scan rate will depend upon
your particular requirements, and requires some consideration of the amount of
integration time and averaging used.  Fast scan rates do not mix with high integration
times.  A 5 to 20 second scan rate is typical.

Integ Time (NPLC)

Integration time is the amount of time that the HP34970 will sample the data on each
channel, and is specified as the number of power line cycles (NPLC).  An integration
time, or NPLC, of 1 means that the channel will be sampled for 1/60th of a second to
determine its measured value.  So in theory, with an integration time of 1, a full
system of 60 channels of data (30 humidities and 30 temperatures) could be sampled
in a matter of just 1-second.  However, this does not include the time required for
channel switching, switch settling, auto-ranging, or RS-232 communication.  In
practice, a scan of a fully loaded system of 30 humidity and 30 temperature channels,
along with 30 auxiliary temperature channels, takes several seconds to make a
complete scan of all channels with an NPLC of 1.  In the case of  an integration time
of 2 or below, it is the switching time and other factors that dominate the minimum
scan time required.

With an NPLC of 10 and higher, the scan time becomes increasingly slower with
these higher integration times.  For example, an NPLC of 20, with a full system of 30
humidity, 30 temperatures, and 30 auxiliary temperatures, may take more than a
minute to perform a complete scan.  During the scan, all ControLog functions are
temporarily locked out, including using the mouse to change windows or select menu
items.  Smaller integration values may result in somewhat noisier data, but allow for
increased system response to user events and allow for better time management for
ControLog so it can do other things, such as communicate with the 2500.  Integration
times of 2 or smaller are generally recommended.

Data Averaging

Noisy signals, whether from noisy sensors or from fast integration times (low NPLC
numbers), may be averaged in order to improve the smoothness.  The averaging
scheme employed within the data acquisition system is that of a running average or
low pass filter.  Consider both the sampling rate and the integration time when
selecting a data averaging value.  Long integration rates and/or less frequent scans can
adversely affect the data results if the averaging is also set high.

Data Averaging values up to 5 or 10 are typical.  A value of 0 is used to disable
averaging.  Large values, near 100 for instance, are considered excessive and may
result in a failure of the indicated data to reach the actual mean of the data being
measured.

Monitor

The monitor option, when selected, causes the data acquisition system to begin
scanning even though ControLog may not be in a generate mode.  This is useful for
testing channel configuration and that the channels are returning reasonable expected
data.  The data measured is visible within the Instrument Data tab.  When ControLog
is in a Generate or Auto-Profile mode, the Monitor option is disabled.
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Instrument Configuration

The Instrument Configuration tab is used to configure the channels for the particular
measurements to be performed.  In this area, each instrument/channel combination is
configured for measurement type, scaling, units, and associated sensor information such as
model number and serial number.

Measurement and scaling parameters in this section apply to the left HP34970A only.  All
instruments are connected to this left HP34970A, while the right one is for auxiliary
temperature measurements only.

Note 1)  No information within this tab can be edited unless the Allow Configuration
Editing option is selected on the System Config tab.

Note 2)  All edited configurations, with the exception of the "active" column, will be
saved upon power down.

Channels

There are thirty rows of paired channel numbers, with labels such as 101/111.  This indicates
that the first channel, for humidity, is identified as 101 on the HP34970A, and that the second
channel in that pair is identified as 111 on the HP34970A, and is used for temperature.

Active

The Active column is used to select which channel-pairs to use.  Any channel-pair, or
combination of channel-pairs, may be selected.  If a channel-pair is not selected as active, it
will not be measured by ControLog, but it may still be configured to the parameters specified
in the remainder of the row.
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Channel-pair activation must be done prior to enabling the Generate or Auto-Profile mode, as
updates to this area are locked out while running.

Channels may be individually selected/de-selected by either using the mouse, or tabbing to
them then toggling on/off with the [Enter] key or space bar.  To globally change all or a
group of them at once, use the mouse to select and drag across the entire group.  With them
all highlighted, press the space bar to toggle the group on/off.  To change all 30 of them at
once, click directly on the column header Active then use the space bar to toggle them all
on/off together.

Model

Use this field to enter a model number for the particular instrument under test that is currently
connected to that channel.  If there are several instruments with the same model number, you
can globally change an entire group of cells at the same time.  Starting with the first cell in
the group, click and drag down to the last cell in the group to highlight them.  Type in the
number, then press [Enter] or [Tab].  The entered value will automatically be pasted into all
the highlighted cells.  An entire column (all 30 cells) may be selected for global editing by
clicking directly on the column header.

Serial

Use this field to enter a serial number for the particular instrument under test that is currently
connected to that channel.  Since serial numbers are unique (or at least should be), there is no
global editing feature associated with the serial number cells.  Serial numbers must be entered
one at a time.

Tag

Use this field to enter a tag number (if applicable) for the particular instrument under test that
is currently connected to that channel.  If there are several instruments with the same tag
number, you can globally change an entire group of cells at the same time.  Starting with the
first cell in the group, click and drag down to the last cell in the group to highlight them.
Type in the number, then press [Enter] or [Tab].  The entered value will automatically be
pasted into all the highlighted cells.  An entire column (all 30 cells) may be selected for
global editing by clicking directly on the column header.

Misc

Use this field to enter any miscellaneous information desired for the particular instrument
under test that is currently connected to that channel.  If there are several instruments
requiring the same miscellaneous information, you can globally change an entire group of
cells at the same time.  Starting with the first cell in the group, click and drag down to the last
cell in the group to highlight them.  Type in the number, then press [Enter] or [Tab].  The
entered value will automatically be pasted into all the highlighted cells.  An entire column
(all 30 cells) may be selected for global editing by clicking directly on the column header.
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Low Signal A

Use this field to enter the instrument's lowest humidity output signal.  For instance, if the
instrument has a 4 to 20 mA humidity output, enter 4 here.  If there are several instruments
requiring the same entry, you can globally change an entire group of cells at the same time.
Starting with the first cell in the group, click and drag down to the last cell in the group to
highlight them.  Type in the number, then press [Enter] or [Tab].  The entered value will
automatically be pasted into all the highlighted cells.  An entire column (all 30 cells) may be
selected for global editing by clicking directly on the column header.

High Signal A

Use this field to enter the instrument's highest humidity output signal.  For instance, if the
instrument has a 4 to 20 mA humidity output, enter 20 here.  If there are several instruments
requiring the same entry, you can globally change an entire group of cells at the same time.
Starting with the first cell in the group, click and drag down to the last cell in the group to
highlight them.  Type in the number, then press [Enter] or [Tab].  The entered value will
automatically be pasted into all the highlighted cells.  An entire column (all 30 cells) may be
selected for global editing by clicking directly on the column header.

Meas Mode A

Use this field to select the instrument's humidity output signal.  For instance, if the instrument
has a 4 to 20 mA output, select mA DC here.  If there are several instruments requiring the
same entry, you can globally change an entire group of cells at the same time.  Starting with
the first cell in the group, click and drag down to the last cell in the group to highlight them.
Press the space bar or enter key to display allowed selections, select the desired value, then
press [Enter] or [Tab].  The entered value will automatically be pasted into all the highlighted
cells.  An entire column (all 30 cells) may be selected for global editing by clicking directly
on the column header.

Low Value A

Use this field to enter the instrument's lowest humidity represented by the output signal.  For
instance, if the instrument's output is to represent 0 to 100% RH, enter 0 here.  If there are
several instruments requiring the same entry, you can globally change an entire group of cells
at the same time.  Starting with the first cell in the group, click and drag down to the last cell
in the group to highlight them.  Type in the number, then press [Enter] or [Tab].  The entered
value will automatically be pasted into all the highlighted cells.  An entire column (all 30
cells) may be selected for global editing by clicking directly on the column header.

High Value A

Use this field to enter the instrument's highest humidity represented by the output signal.  For
instance, if the instrument's output is to represent 0 to 100% RH, enter 100 here.  If there are
several instruments requiring the same entry, you can globally change an entire group of cells
at the same time.  Starting with the first cell in the group, click and drag down to the last cell
in the group to highlight them.  Type in the number, then press [Enter] or [Tab].  The entered
value will automatically be pasted into all the highlighted cells.  An entire column (all 30
cells) may be selected for global editing by clicking directly on the column header.
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Gain A (only visible if Specify Inst Gain and Offset option is selected within the System
Config tab)

Use this field to enter the instrument's gain or scaling factor required to convert the raw
output signal into the desired humidity value.  For instance, if the instrument's output is 4 to
20 mA for 0 to 100% RH, compute the gain as

HumidityRange/SignalRange = [HighHumidity-LowHumidity] / [HighSignal/LowSignal]
= [100-0] / [20-4]
= 6.25

and enter 6.25 here.  If there are several instruments requiring the same entry, you can
globally change an entire group of cells at the same time.  Starting with the first cell in the
group, click and drag down to the last cell in the group to highlight them.  Type in the
number, then press [Enter] or [Tab].  The entered value will automatically be pasted into all
the highlighted cells.  An entire column (all 30 cells) may be selected for global editing by
clicking directly on the column header.

Offset A (only visible if Specify Inst Gain and Offset option is selected within the System
Config tab)

Use this field to enter the instrument's offset factor required to convert the raw output signal
into the desired humidity value.  For instance, if the instrument's output is 4 to 20 mA for 0 to
100% RH, compute the offset as

GainA * [LowHumidity -LowSignal] = 6.25* [0-4]
= -25

and enter -25 here.  If there are several instruments requiring the same entry, you can globally
change an entire group of cells at the same time.  Starting with the first cell in the group, click
and drag down to the last cell in the group to highlight them.  Type in the number, then press
[Enter] or [Tab].  The entered value will automatically be pasted into all the highlighted cells.
An entire column (all 30 cells) may be selected for global editing by clicking directly on the
column header.

Units A

Use this field to select the humidity units to represent.  For instance, if the instrument has a 4
to 20 mA output, for 0 to 100% RH, you would select %RH.  If there are several instruments
requiring the same entry, you can globally change an entire group of cells at the same time.
Starting with the first cell in the group, click and drag down to the last cell in the group to
highlight them. Press [Space Bar] or [Enter]to display allowed selections, select the desired
value, then press [Enter] or [Tab].  The entered value will automatically be pasted into all the
highlighted cells.  An entire column (all 30 cells) may be selected for global editing by
clicking directly on the column header.

When set to either Dew Point or Frost Point, this field reflects the units to use (˚C, ˚F, or K)
during the measurement and scaling process only.  The resulting Dew or Frost Point will then
be displayed in the current ControLog temperature units.
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Low Signal B

Use this field to enter the instrument's lowest temperature output signal.  For instance, if the
instrument has a 0 to 5 VDC temperature output, enter 0 here.  If there are several
instruments requiring the same entry, you can globally change an entire group of cells at the
same time.  Starting with the first cell in the group, click and drag down to the last cell in the
group to highlight them.  Type in the number, then press [Enter] or [Tab].  The entered value
will automatically be pasted into all the highlighted cells.  An entire column (all 30 cells)
may be selected for global editing by clicking directly on the column header.

High Signal B

Use this field to enter the instrument's highest temperature output signal.  For instance, if the
instrument has a 0 to 5 VDC temperature output, enter 5 here.  If there are several
instruments requiring the same entry, you can globally change an entire group of cells at the
same time.  Starting with the first cell in the group, click and drag down to the last cell in the
group to highlight them.  Type in the number, then press [Enter] or [Tab].  The entered value
will automatically be pasted into all the highlighted cells.  An entire column (all 30 cells)
may be selected for global editing by clicking directly on the column header.

Meas Mode B

Use this field to select the instrument's type of temperature output signal.  For instance, if the
instrument has a 0 to 5 VDC output, select Volts DC here.  If there are several instruments
requiring the same entry, you can globally change an entire group of cells at the same time.
Starting with the first cell in the group, click and drag down to the last cell in the group to
highlight them. Press the space bar or enter key to display allowed selections, select the
desired value, then press [Enter] or [Tab].  The entered value will automatically be pasted
into all the highlighted cells.  An entire column (all 30 cells) may be selected for global
editing by clicking directly on the column header.

This channel is capable of measuring temperature directly from an RTD, PRT, or Thermistor,
but is only capable of doing so in 2-wire mode.  4-wire measurement mode is not available
on these channels.  When using RTDs, PRTs, or Thermistors, it is best to set the GainB and
OffsetB values to 1 and 0 respectively unless you have knowledge of other values specific to
the probe from a previous calibration.

Low Value B

Use this field to enter the instrument's lowest temperature represented by the output signal.
For instance, if the instrument's output is to represent 0 to 100˚F, enter 0 here.  If there are
several instruments requiring the same entry, you can globally change an entire group of cells
at the same time.  Starting with the first cell in the group, click and drag down to the last cell
in the group to highlight them.  Type in the number, then press [Enter] or [Tab].  The entered
value will automatically be pasted into all the highlighted cells.  An entire column (all 30
cells) may be selected for global editing by clicking directly on the column header.
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High Value B

Use this field to enter the instrument's highest temperature represented by the output signal.
For instance, if the instrument's output is to represent 0 to 100˚F, enter 100 here.  If there are
several instruments requiring the same entry, you can globally change an entire group of cells
at the same time.  Starting with the first cell in the group, click and drag down to the last cell
in the group to highlight them.  Type in the number, then press [Enter] or [Tab].  The entered
value will automatically be pasted into all the highlighted cells.  An entire column (all 30
cells) may be selected for global editing by clicking directly on the column header.

Gain B (only visible if Specify Inst Gain and Offset option is selected within the System
Config tab)

Use this field to enter the instrument's gain or scaling factor required to convert the raw
output signal into the desired temperature value.  For instance, if the instrument's output is 0
to 5 VDC for 0 to 100˚F, compute the gain as

TemperatureRange/SignalRange = [HighTemp-LowTemp]/[HighSignal-LowSignal]
= [100-0] / [5-0]
= 20

and enter 20 here.  If there are several instruments requiring the same entry, you can globally
change an entire group of cells at the same time.  Starting with the first cell in the group, click
and drag down to the last cell in the group to highlight them.  Type in the number, then press
[Enter] or [Tab].  The entered value will automatically be pasted into all the highlighted cells.
An entire column (all 30 cells) may be selected for global editing by clicking directly on the
column header.

Offset B (only visible if Specify Inst Gain and Offset option is selected within the System
Config tab)

Use this field to enter the instrument's offset factor required to convert the raw output signal
into the desired temperature value.  For instance, if the instrument's output is 0 to 5 VDC for
0 to 100˚F, compute the offset as

GainA * [LowTemperature-LowSignal] = 20* [0-0]
= 0

and enter 0 here.  If there are several instruments requiring the same entry, you can globally
change an entire group of cells at the same time.  Starting with the first cell in the group, click
and drag down to the last cell in the group to highlight them.  Type in the number, then press
[Enter] or [Tab].  The entered value will automatically be pasted into all the highlighted cells.
An entire column (all 30 cells) may be selected for global editing by clicking directly on the
column header.
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Units B

Use this field to select the temperature units to represent.  For instance, if the instrument has
0 to 5 VDC output, for 0 to 100˚F, select ˚F.  If there are several instruments requiring the
same entry, you can globally change an entire group of cells at the same time.  Starting with
the first cell in the group, click and drag down to the last cell in the group to highlight them.
Press [Space Bar] or [Enter] to display allowed selections, select the desired value, then press
[Enter] or [Tab].  The selected value will automatically be pasted into all the highlighted
cells.  An entire column (all 30 cells) may be selected for global editing by clicking directly
on the column header.

This field reflects the temperature units to use (˚C, ˚F, or K) during the measurement and
scaling process only.  The resulting temperature will then be displayed in the current
ControLog temperature units.

Temperature Configuration

The Temperature Configuration tab is used to configure Auxiliary Temperature probes (if
used).  In this area, each probe is configured for type, gain, offset, and temperature units.

When auxiliary temperature probes are used, there are typically groups of ten temperature
probes each labeled A1 through A10, B1 through B10, etc., or groups of ten prefixed with
any letter up to Z.  Before use, these probes should be calibrated in the system to gain and
offset values.  These values are stored (manually) in sysfiles\AuxTemp.ini for later retrieval
by ControLog.  As originally shipped without auxiliary temperature probes, the AuxTemp.ini
file is pre-loaded with gains and offsets of 1 and 0 respectively for all probe combination
from A1 through Z10.  If calibrating your own temperature probes for use as auxiliary
temperature measurements, you must manually edit the AuxTemp.ini file with the
appropriate gain and offset values for each probe.  See Auxiliary Temperature Probe
Calibration.
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Measurement and scaling parameters in this section apply to the right HP34970A only.  All
auxiliary temperature probes are connected to this (right) HP34970A, while the left one is for
instrument connections of humidity/temperature.  It is important to understand the distinction
between instrument temperatures measured with the left HP34970A, and auxiliary
temperatures measured with the right one.

Note that no information within this tab can be edited unless the Allow Configuration Editing
option is selected on the System Config tab.

Channels

There are thirty paired channels with number labels such as 101/111.  These are paired
channels to allow for either 2-wire or 4-wire resistance (temperature) measurements.  The
first listed channel number in a pair, 101 for example, is the channel we read the measured
value from.  The channel-pair combination, such as 101/111 indicates the current-source,
voltage-sense pair for 4 wire measurements.  Regardless of the 2 or 4-wire mode, the lower
channel is always the one measured.  Also note that these channel numbers correspond
exactly with those of the Instrument Configuration tab.  These auxiliary temperature
measurements are coupled with the corresponding instrument humidity/temperature channel-
pairs.  For instance, an auxiliary temperature measurement on channel 204/214 is the one
used to perform auxiliary humidity computations (if applicable) on the instrument
humidity/temperature connected to its channel 204/214 combination.  It is important to note
then which auxiliary probes are used with which humidity/temperature instruments.

Active

The Active column mimics that of the Instrument Config tab.  An active instrument channel
results in an active auxiliary temperature channel.  Activity changes can only be performed
within the Instrument Config tab.

Model

This field is a copy of the information entered from within the Instrument Config tab and can
not be edited from here.

Serial

This field is a copy of the information entered from within the Instrument Config tab and can
not be edited from here.

Tag

This field is a copy of the information entered from within the Instrument Config tab and can
not be edited from here.

Misc

This field is a copy of the information entered from within the Instrument Config tab and can
not be edited from here.



80 Data Acquisition

Probe ID

This field is used to enter a probe ID which is then used to look up probe specific calibration
data from the auxiliary temperature probe calibration file sysfiles\AuxTemp.ini.  From this
file, the Meas Mode, Gain, Offset, and Units fields will automatically fill in with the
appropriate information specific to that probe.  It is recommended that probes be connected in
groups of ten, in alpha-numeric order. Rather than entering individual probe IDs, they can be
entered globally.  Global entries in the Probe ID column auto increment A1 through A10,
then to B1 through B10, etc.  If, for instance, your probe ID groups are J, K, and L, you could
globally enter all 30 probes by clicking once on the column header to highlight the entire
group, then J and press [Enter].  The probe IDs will automatically fill in with J1 through J10,
K1 through K10, and L1 through L10.  All of the appropriate Meas Mode, Gain, Offset, and
Units data stored within the sysfile/AuxTemp.ini calibration file for each of the probes will
then appear in the respective cells.

Meas Mode

This field may be used to change the measurement mode for the auxiliary temperature probe.
The probe may be either a 2-wire or 4-wire configuration, and may be any of a wide variety
of types.  Note that changes made to this field are volatile and will be overwritten by a
change made to the Probe ID field.  Changes here do not cause a change to the calibration
data file sysfiles\AuxTemp.ini.  Any permanent changes required must be manually entered
into the sysfiles\AuxTemp.ini file directly using a text editor or spreadsheet program capable
of creating delimited text files.

Gain

This field may be used to change the calibration gain for the auxiliary temperature probe
Note that changes made to this field are volatile and will be overwritten by a change made to
the Probe ID field.  Changes here do not cause a change to the calibration data file
sysfiles\AuxTemp.ini.  Any permanent changes required must be manually entered into the
sysfiles\AuxTemp.ini file directly using a text editor or spreadsheet program capable of
creating delimited text files.

Offset

This field may be used to change the calibration offset for the auxiliary temperature probe
Note that changes made to this field are volatile and will be overwritten by a change made to
the Probe ID field.  Changes here do not cause a change to the calibration data file
sysfiles\AuxTemp.ini.  Any permanent changes required must be manually entered into the
sysfiles\AuxTemp.ini file directly using a text editor or spreadsheet program capable of
creating delimited text files.

Units

This field may be used to change the calibration units for the auxiliary temperature probe
Note that changes made to this field are volatile and will be overwritten by a change made to
the Probe ID field.  Changes here do not cause a change to the calibration data file
sysfiles\AuxTemp.ini.  Any permanent changes required must be manually entered into the
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sysfiles\AuxTemp.ini file directly using a text editor or spreadsheet program capable of
creating delimited text files.

This field reflects the temperature units used during the calibration of the probe only and is
subsequently used during the measurement and scaling process only.  The resulting auxiliary
temperature will be displayed in the current ControLog temperature units.

Instrument Data

The Instrument Data tab is used to view the instrument and auxiliary data.  This is a view
only informational screen, with no cells or fields to edit.

However, the first time it is viewed, or the first time it is re-viewed following a configuration
change to either the Instrument Config or Temperature Config tabs, it forces an update to
configuration information held within the HP34970A systems.  In other words, this tab must
be opened, at least once and again after configuration changes, in order to properly configure
the HP34970A systems.  As the configuration information is sent to each HP34970A, a small
progress bar moves along the bottom of the Data Acquisition window.  This operation can
take nearly half a minute to complete.  The progress bar moves across the screen twice, once
for the left HP34970A configuration, then again for the right HP34970A.

Once the meters are configured, and the progress bar again disappears, neither this tab, nor
the Data Acquisition window, needs to remain open.  Like the rest of ControLog, even if the
window is closed, data is still collected and stored normally.  In addition, the instrument and
auxiliary data is available for graphing along with the normal ControLog data.  The only
benefit of having this window open is that you can numerically see the data.

Channels

The channel numbers correspond with those of the Instrument Config and Temperature
Config tabs.
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Active

The Active column mimics that of the Instrument Config tab.  An active instrument channel
results in visible measurements in this Instrument Data tab.  Activity changes can only be
performed within the Instrument Config tab, and can not be edited from here.

Model

This field is a copy of the information entered from within the Instrument Config tab and can
not be edited from here.

Serial

This field is a copy of the information entered from within the Instrument Config tab and can
not be edited from here.

Tag

This field is a copy of the information entered from within the Instrument Config tab and can
not be edited from here.

Misc

This field is a copy of the information entered from within the Instrument Config tab and can
not be edited from here.

Hum Signal

The Humidity Signal column is only visible if the Show Raw Signal Data option from the
System Config tab is selected.  When visible, this field displays the instrument's humidity
output signal prior to scaling into the desired humidity units.

Temp Signal

The Temperature Signal column is only visible if the Show Raw Signal Data option from the
System Config tab is selected.  When visible, this field displays the instrument's temperature
output signal prior to scaling into the desired temperature units.

Inst Humidity

This field displays the instrument's scaled humidity measurement data.  If the Append Units
to Inst Data option is selected from the System Config tab, the corresponding units will be
appended within this same field immediately following the data.  If the displayed humidity is
a Dew or Frost Point temperature, then the temperature units will be those currently selected
for the ControLog system.
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Inst Temp

This field displays the instrument's scaled temperature measurement data.  If the Append
Units to Inst Data  option is selected from the System Config tab, the corresponding units will
be appended within this same field immediately following the data.  Since the displayed
value is a temperature, the temperature units will be those currently selected for the
ControLog system.

Aux Humidity

This field displays the auxiliary humidity computed as specified in the Auxiliary Humidity
Computation  section of the System Config tab.  If the Append Units to Inst Data option is
selected from the System Config tab, the corresponding units will be appended within this
same field immediately following the data.  If the displayed humidity is a Dew or Frost Point
temperature, then the temperature units will be those currently selected for the ControLog
system.

Aux Temp

This field displays the auxiliary temperature measurement data (if applicable).  If the Append
Units to Inst Data option is selected from the System Config tab, the corresponding units will
be appended within this same field immediately following the data.  Since the displayed
value is a temperature, the temperature units will be those currently selected for the
ControLog system.
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The Daux.ini File

The System Config tab in the Data Acquisition window is preset to specific default values
when ControLog is launched.  The data used to set these values is retrieved from the Daux.ini
file within the sysfiles folder.  ControLog treats this as a read only file and never writes to or
updates it in any way.  If changes are to be made to this file, in order to alter the System
Configuration settings of the Data Acquisition, then those changes must be done manually
using a standard text editor such a NotePad or WordPad.  The file should be saved in plain
text format only.
The following is a list of the Daux.ini file, followed by a brief explanation of each parameter.

IDN,"HEWLETT-PACKARD,34970A"
CType,"34901A"
Authorization,496
Authorization2,1022
CommPortA,3
BaudRateA,9600
DataBitsA,8
ParityA,None
FlowA,RtsCts
CommPortB,4
BaudRateB,9600
DataBitsB,8
ParityB,None
FlowB,RtsCts
Compute,"%RH"
FromA,"2500"
FromB,"Auxiliary"
DA2Temps,2
ShowUnits,1
ScanRate,5
ScanRateMin,1
LoadResistor,500
NPLC,2
Averaging,10
SaveConfigOnQuit,0
AutoSaveDataFiles,2
LongFileNames,2
DataAcqEnabled,1
SpecifySignalGainAndOffset,0
AutoClearRPTFiles,-1
Locked,-1
lockWhileRunning,-1

IDN

"HEWLETT-PACKARD,34970A" is the exact expected response string from the HP34970A
meters during the detection phase while launching ControLog.  If the response, or lack of
response, does not exactly match this IDN data, then ControLog reverts to normal operation
without data acquisition.
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CType

"34901A" is the exact expected response string to a card type query executed from the
HP34970A meters during the detection phase while launching ControLog. If the response, or
lack of response, does not exactly match this IDN data, then ControLog reverts to normal
operation without data acquisition.

Authorization

This is an encoded lower level password.  When you click on the Allow Configuration
Editing option, you are prompted for a password.  If the password entered, after going
through a numeric algorithm, produces the same value as is stored here, it is authorized.
When authorized, configuration of the Instrument Config and Temperature Config
information is allowed.  System Config parameters are still not allowed though.  If not
authorized, then the Allow Configuration Editing option remains de-selected and editing of
the system,  instrument, and temperature configuration is not allowed.
The password algorithm is:

Authorization = [length(password)] + [1*asc(char(1))] + [2*asc(char(2))] + … +[n*asc(char(n))]

For instance, the password 2500 should result in

Authorization = [length("2500")] + [1*asc("2")] + [2*asc("5")] + [3*asc("0")] + [4*asc("0")]
= [4] + [1*50] + [2*53] + [3*48] + [4*48]
= 496

Authorization2

This is an encoded higher level password.  When you click on the Allow Configuration
Editing option, you are prompted for a password.  If the password entered, after going
through a numeric algorithm, produces the same value as is stored here, it is authorized.
When authorized, configuration of the System Config parameters are allowed, as well as
altering of Instrument Config and Temperature Config information as is allowable with the
lower level password.  If not authorized, then the Allow Configuration Editing option
remains de-selected and editing of the system, instrument, and temperature configuration is
not allowed.  The password algorithm is identical to the Authorization algorithm above.

CommPortA

(Default = 3)
The value here appears in the Comm Port field of the DA1 Communications section of the
System Config tab of the Data Acquisition window.  This identifies the COMM port to use for
communication with the leftmost HP34970A multimeter.  The COMM port chosen must
physically exist in the computer, and must be uniquely different from any other COMM port
used for any other function.  The same COMM port can not be used for both HP34970A
systems, nor can this same port be used for communication with the 2500.
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BaudRateA

(Default = 9600)
The value here appears in the Baud Rate field of the DA1 Communications section of the
System Config tab of the Data Acquisition window.  BaudRateA is the baud rate used for
communication with the leftmost HP34970A multimeter.  This must match the baud rate
selected within the HP34970A.  For information regarding the HP34970A communication
settings, see the HP documentation or The HP34970A  communication interface.

DataBitsA

(Default = 8)
The value here appears in the Parity/Bits field of the DA1 Communications section of the
System Config tab of the Data Acquisition window.  DataBitsA is the number of data bits (7
or 8) per frame used for communication with the leftmost HP34970A multimeter.  This must
match the data bits selected within the HP34970A.  For information regarding the HP34970A
communication settings, see the HP documentation or The HP34970A communication
interface.

ParityA

(Default = None)
The value here appears in the Parity/Bits field of the DA1 Communications section of the
System Config tab of the Data Acquisition window.  ParityA is the parity (None, Odd, or
Even) used for communication with the leftmost HP34970A multimeter.  This must match
the parity selected within the HP34970A.  For information regarding the HP34970A
communication settings, see the HP documentation or The HP34970A communication
interface.

FlowA

(Default = RtsCts)
The value here appears in the Flow Control field of the DA1 Communications section of the
System Config tab of the Data Acquisition window.  FlowA defines the handshaking (None,
XonXoff, or RtsCts) used for communication with the leftmost HP34970A multimeter.  This
must match the handshaking selected within the HP34970A. For information regarding the
HP34970A communication settings, see the HP documentation or The HP34970A
communication interface.

CommPortB

(Default = 4)
The value here appears in the Comm Port field of the DA2 Communications section of the
System Config tab of the Data Acquisition window.  This identifies the COMM port to use for
communication with the rightmost HP34970A multimeter.  The COMM port chosen must
physically exist in the computer, and must be uniquely different from any other COMM port
used for any other function.  The same COMM port can not be used for both HP34970A
systems, nor can this same port be used for communication with the 2500.



Data Acquisition 87

BaudRateB

(Default = 9600)
The value here appears in the Baud Rate field of the DA2 Communications section of the
System Config tab of the Data Acquisition window.  BaudRateB is the baud rate used for
communication with the rightmost HP34970A multimeter.  This must match the baud rate
selected within the HP34970A.  For information regarding the HP34970A communication
settings, see the HP documentation or The HP34970A communication interface.

DataBitsB

(Default = 8)
The value here appears in the Parity/Bits field of the DA2 Communications section of the
System Config tab of the Data Acquisition window.  DataBitsB is the number of data bits (7
or 8) per frame used for communication with the rightmost HP34970A multimeter.  This
must match the data bits selected within the HP34970A.  For information regarding the
HP34970A communication settings, see the HP documentation or The HP34970A
communication interface.

ParityB

(Default = None)
The value here appears in the Parity/Bits field of the DA2 Communications section of the
System Config tab of the Data Acquisition window.  ParityB is the parity (None, Odd, or
Even) used for communication with the rightmost HP34970A multimeter.  This must match
the parity selected within the HP34970A.  For information regarding the HP34970A
communication settings, see the HP documentation or The HP34970A communication
interface.

FlowB

(Default = RTS/CTS)
The value here appears in the Flow Control field of the DA2 Communications section of the
System Config tab of the Data Acquisition window.  FlowB defines the handshaking (None,
XonXoff, or RtsCts) used for communication with the rightmost HP34970A multimeter.
This must match the handshaking selected within the HP34970A. For information regarding
the HP34970A communication settings, see the HP documentation or The HP34970A
communication interface.

Compute

This is the parameter that will be computed as the Auxiliary Humidity value.  It appears in
the Compute Auxiliary Humidity Parameter field of the Auxiliary Humidity Computation
section of the System Config tab of the Data Acquisition window.

FromA

This parameter identifies the humidity source that will be used when computing Auxiliary
Humidity.  It appears in the using humidity from field of the Auxiliary Humidity Computation
section of the System Config tab of the Data Acquisition window.
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FromB

This parameter identifies the temperature that will be used when computing Auxiliary
Humidity.  It appears in the & temperature from  field of the Auxiliary Humidity Computation
section of the System Config tab of the Data Acquisition window.

DA2Temps

(Default = 2)
This parameter was intended for future expansion, and as such is not yet fully implemented.
It identifies the type of data to be measured with the rightmost HP34970A multimeter.  The
following values, while not yet implemented, are planned:

0 - allow DA2 to be used for any valid measurements
1 - only allow DA2 to be used for auxiliary temperature measurements
2 - same as 1, but lock the option and prevent it from being changed by the   
     operator.

ShowUnits

(Default = 1)
This is the Append Units to Instrument Data checkmark of the Options section of the System
Config tab of the Data Acquisition window.  It has the following options:

0 - unchecked.  Do not show units with the Instrument Data
1 - checked.  Show units with the Instrument Data
2 - same as 1, but lock the checkmark and prevent it from being changed by the   
     operator.

ScanRate

Appears in the Scan Rate (seconds) field of the Options section of the System Config tab of
the Data Acquisition window.  Valid range is 1 to 60.

ScanRateMin

Use this to set the minimum Scan Rate value selected by the operator.  Allowable values are
1 to 60.  If set below 1, the minimum scan rate is still 1.

LoadResistor

Use this to set the nominal value of the load resistor used during current measurements.  All
current measurements are made by measuring the voltage dropped across a load resistor
within the personality module plugged into the front of the data acquisition panel.  Each
personality module set for current measurement contains high precision resistors in series
with the current flow.  The voltage developed is measured by the HP34970A and is then
divided by the resistance specified here to determine the current.  This is a single global value
and as such requires that all resistors used for current measurements be of the same nominal
value.  Resistor tolerances of ±0.01% are recommended.
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NPLC

NPLC is the Number of Power Line Cycles used in the measurement of each channel.  It has
a direct affect on the quality of the measurement and the amount of noise that can be rejected.
It appears in the NPLC field of the Options section of the System Config tab of the Data
Acquisition window.

Averaging

Use this to set the amount of averaging used when measuring instrument data.  It appears in
the Averaging field of the Options section of the System Config tab of the Data Acquisition
window.  A value of 0 equates to no averaging.  Values up to 10 are typical.

SaveConfigOnQuit

This parameter was intended for future expansion, and as such is not yet fully implemented.
When implemented, it is intended to allow the operator selected parameters of the System
Config tab of the Data Acquisition window to update the Daux.ini file.  Presently, this is not
the case, and the Daux.ini file must be altered manually using a text editor (such as notepad
or wordpad).

AutoSaveDataFiles

This parameter specifies whether or not to automatically save data files at the end of a run.  If
enabled, the data files are saved using a date/time stamp as the filename.  If not, then the user
is prompted to save the file, and asked for a valid filename.  The following values are
acceptable:

0 - prompt user to save file, then ask for filename
non 0 - automatically save the file using a date/time stamp as the filename

LongFileNames

When AutoSaveFileNames is enabled ( AutoSaveFileNames = 1 or 2), the date/time stamp
used for the filename can either be kept short to maintain DOS compatibility (8 characters) or
can be longer as allowed by Windows 95/NT.  When short, only the date portion of the
filename is used, meaning that a file may have more than one run worth of data in it.  With
long filenames, each file contains only one run since the filename includes both date & time.
Each run therefore has a unique long filename.  The following values are acceptable:

0 - use short filenames only (date only) in DOS compatible format
non 0 - use long filenames with both date and time

DataAcqEnabled

This determines the initial status of the Enable Data Acquisition checkmark of the Options
section of the System Config tab of the Data Acquisition window.  The following values are
acceptable:

0 - checkmark of Enable Data Acquisition initially OFF
non 0 - checkmark of Enable Data Acquisition is initially ON.
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SpecifySignalGainAndOffset

This determines the initial state of the Specify Inst Gain and Offset checkmark of the Options
sections of the System Config tab of the Data Acquisition window.  The following values are
acceptable:

0 - checkmark of Specify Inst Gain and Offset initially OFF
non 0 - checkmark of Specify Inst Gain and Offset initially ON.

AutoClearRPTFiles

This specifies whether or not to automatically clear the report files at the beginning of each
new run.  If enabled (value is non 0), the report files are cleared at the start of each new run
just as if the user had selected Clear Report Files from the Reports menu.  If disabled (value
is 0), then the report files are not cleared and the data from each new run is appended to the
data from the previous runs.  In this manner, the report files (stored in the sysfiles folder)
grow increasingly larger in size with each new run and require clearing manually.

Locked

This determines the initial state of the items contained on the System Config tab of the Data
Acquisition window.  If Locked (value is non 0), then the DA1 and DA2 Communication
parameters and the Auxiliary Humidity Computation parameters are not editable until the
Allow Configuration Editing checkmark is turned on and the level 2 password (encrypted in
the Authorization2 variable above) is entered.  However, if not Locked (value = 0) then the
DA1 and DA2 Communication parameters and the Auxiliary Humidity Computation
parameters are editable initially without checking Allow Configuration Editing or entry of a
password.  Note that once Allow Configuration Editing has been checked, the password is
subsequently required for access to these parameters.  The Locked variable only affects the
initially locked status of these parameters.

LockWhileRunning

This determines whether or not to lock out all configuration editing while in Generate or
Auto-Profile (i.e., the 2500 is running), including DA1 and DA2 Communication parameters,
Auxiliary Humidity Computation parameters, Instrument Configuration, and Temperature
Configuration.  When locked (value is non 0), all parameters are locked and can not be
altered when running.  When unlocked (value=0), the user is free to make changes to the
configuration while running, provided that Allow Configuration Editing is checked and the
proper password has been entered.  Changing configuration while the system is running can
have a negative impact on the data collection files being written, and/or may lock up the
system due to communication errors.  It is good practice to leave configuration locked while
running.
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Channel Monitor

The Channel Monitor, located under the Window menu, is used to display any of the channels
of the left HP34970A used by the 9800 Data Acquisition System.  These channels include
101 through 120, 201 through 220, and 301 through 320.  Channels 121, 122, 221, 222, 321,
and 322 are not configured by the 9800 system and are not usable by the channel monitor.
The Channel Monitor displays both the raw measured value (voltage, current, resistance,
temperature, etc.) and the scaled value in its selected engineering units (RH, dewpoint, ˚F, ˚C,
etc.)  In addition, the Channel Monitor either displays the corresponding auxiliary
temperature channel from the right HP34970A (if the currently selected instrument signal is a
temperature channel) or the computed auxiliary humidity (if the currently selected instrument
signal is a humidity channel).

Changing Channels

The Channel Monitor displays only one channel of a channel pair at a time, along with its
corresponding auxiliary temperature or humidity value.  The displayed channel may be
changed in either of two ways:

1. Rotate the channel knob on the front of the leftmost HP34970A to the 
desired channel number as indicated on the HP front panel, or

2. Click the up/down arrow buttons on the Channel Monitor window. The 
channel number will increment/decrement accordingly.

Note that regardless of the method chosen, the channel number field updates to reflect the
currently selected channel number.  When changing channel number using the knob, always
do so using the leftmost HP34970A.  The knob on the other one has no affect on the Channel
Monitor.  Also note that while the instrument signal and corresponding humidity or
temperature (depending on which of the channel pair is selected) updates rather quickly.  The
corresponding auxiliary humidity or temperature updates much more slowly along with the
normal scan rate as selected on the System Config tab of the Data Acquisition window.

Channel Pairing vs. Meter Pairing

Remember that the instrument data channels are paired together in the leftmost HP34970A so
that channels 101 through 110 (instrument humidities) pair with channels 111 through 120
(instrument temperatures) respectively.  So to view the humidity of the 3rd instrument
channel, tune to channel 103.  Likewise, to see the corresponding temperature as measured
from the same instrument, tune to channel 113.  This is called channel-pairing.

Instrument-pairing refers to the linking of auxiliary temperature measurements from the right
HP34970A to the corresponding humidity/temperature channel pairs of the left HP34970A.
As in the previous example, an instrument connected to the 3rd channel gives humidity on
channel 103 and temperature on channel 113 of the left HP34970A.  The corresponding
auxiliary temperature measurement is made on channel 103 of the rightmost HP34970A.
This is referred to as meter-pairing.
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High Priority and the Wait Indicator

When the Wait flag is visible near the upper right of the Channel Monitor window, it
indicates that the system is busy performing a complete group channel scan or other
communication chore.  During this time, the data on the Channel Monitor window is frozen.
Once the group scan is complete, the flag extinguishes, and the channel monitor attempts to
once again measure and update the selected channel several times per second.  The Wait flag
appears periodically, coincident with the scan rate selected.

During times when attempting to make adjustments to instruments, and relying on the data
from the Channel Monitor, it is desirable to make these periodic Wait interruptions hold off
as much as possible.  By checking High Priority, the Channel Monitor gains priority over
other communication processes.  The periodic group scan which causes the Wait flag to
appear now holds off for much longer periods.  Since the system must still occasionally make
these scanned group measurements, it will still gain control approximately once per minute,
showing the Wait flag for a few seconds during this time.  However, the Wait flag appears
much less frequently than before.

When High Priority is selected, the normal data scan rate (and thus the data averaging) is
adversely affected.  Rather than being able to scan the 2500 and the 9800 instrument data
channels frequently enough to provide good averaged data, the data gathering frequency is
reduced, resulting in a significantly fewer number of measurements used in the average.
Therefore, with High Priority checked, the averaged data may not actually achieve the true
mean of the data being sampled.  For this reason, it is best to check High Priority only when
required, and turn it back off once it is no longer needed.  Closing the Channel Monitor
window will also disable High Priority and allow the system to return to normal operation.

Auxiliary Temperature Probe Calibration

Calibration of auxiliary temperature probes for use with the rightmost HP34970A is not an
automated process and requires the use of an external temperature bath, a temperature
reference, Microsoft Excel (or a similar spreadsheet program), a text editor, and some
copying/pasting.  The following procedures should give you a good outline to follow in
calibrating your particular probes.  Calibration is used to individually correct the gain and
offset values of probes, but is not capable of compensating for probe non-linearity, hysteresis,
or non-repeatability.

1. Separate the probes into groups of 10, grouping like type probes together.  
Give each group a letter designation and number each probe within the 
group, such as A1 through A10 for the first group, B1 through B10 for the 
second group, and so on.  Any letter of the alphabet is fine, but it is best to 
keep the groups consecutively lettered.  For instance, if there are three 
groups of ten probes each, give them group letters of A, B, and C perhaps, 
or J, K, and L. Label the probes with the group and number designations on 
each end of each cable.

 2. Connect the probes to the rightmost channel connections of the 9800 
underneath the right HP34970A.  Connect them according to their group 
and channel numbers, lowest letters on top, lowest number to the left.  If 
your probes are labeled A1 - A10, B1 - B10, and C1 - C10, put the A group 
on top, starting with A1 connected to channel 101/111, A2 to channel 
102/112, and so on.  Put the B group on the next row down, followed by 
the C group on the bottom row.
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 3. Configure the Data Acquisition window's Temperature Config tab with the 
probe IDs (labels), probe type (thermistor, thermocouple, RTD, etc.) and 
measurement type (2 or 4 wire).

4. Globally set the Gain and Offset parameters to 1 and 0 respectively so we 
get unaltered raw temperature data from the HP34970A.

 5. Place the probes in a temperature bath, bundled together with a reference 
thermometer.

 6. Shutdown the system if in Generate or Auto-Profile mode.

 7. Uncheck the Append Units to Inst Data box of the Options section of the 
System Config tab of the Data Acquisition window.

8. Click to select the Monitor checkbox within this same section.  This starts 
the measurement scan process even though the 2500 is not generating.

 9. If desired, use the graph menu to select the auxiliary temperature channels, 
and enable strip chart mode.  The probe data then appears on the graph 
within a few seconds.

10. Set the bath temperature to the low end of the calibration range of interest.

11. Watch for stable data in the Aux Temp column of the Instrument Data tab of 
the Data Acquisition window.

12. Once stable, note the reading of the reference thermometer.  Select and copy 
the raw temperature data displayed in Aux Temp column.

13. Open the file sysfiles\TempCalForm.xls using Microsoft Excel or a 
compatible spreadsheet program. Enter the reference thermometer's value 
into the Low Standard(blue) and paste the copied Aux Temp data from 
the previous step into the Low (blue) column.

14. Set the bath temperature to the upper end of the calibration range of interest.

15. Once stable, note the reading of the reference thermometer, and again copy 
the Aux Temp data from ControLog.

16. Returning to Excel, enter the reference thermometer's value into the High 
Standard(red) cell, and paste the copied Aux Temp data into the High 
(red) column.

17. The new Gain and Offset (yellow) columns now hold the newly computed 
gain and offset values specific to each probe.  Select and Copy this Gain and 
Offset data as a group.

18. Using Excel, open the file sysfiles\AuxTemp.ini.  Choose Delimited, and 
Comma separated in the data import dialog boxes that appear.  Once opened, 
it should have a listing for all probes from A1 to Z10 for a total of 260 data 
line entries, plus a header line.

19. Find the appropriate rows corresponding to the labels for the probes just 
calibrated.  Then select the Gain and Offset data for this group.  Select Paste 
Special... from the Edit menu.  In the dialog box that appears, select the 
Values option so that the numbers paste in here rather than the formulas that 
were used to get those numbers.  Click OK.
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20. Make sure the probe type is correct for each probe being calibrated.  If it is 
not, then change it to the correct value exactly as it is listed in the Meas 
Mode column of the Temperature Config tab of the Data Acquisition 
window of ControLog.

21. Make sure the Units column agrees with the units used during the calibration .

22. Once the data of the AuxTemp.ini file appears correct, select Save As... 
from the File menu.  In the dialog box, select CSV (Comma Delimited) as 
the file type.  If you do not select CSV, the file will be written in a format 
incompatible with ControLog.

23. Once the file is saved, it may have been renamed by Excel to something like 
"AuxTemp.ini.csv".  Using the Windows Explorer, go rename the file 
back to AuxTemp.ini so that it can be found by ControLog.  You may also 
want to open it up once with a simple text editor.  If it looks readable, and 
comma separated, then most likely it was saved correctly.

24. Quit ControLog.

25. Re-launch ControLog.  This causes it to re-read the AuxTemp.ini file you 
just changed.

26. Go to the Temperature Config tab of the Data Acquisition window in 
ControLog.  Change the probe ID column to the probes just calibrated.  The 
Meas Mode, Gain, Offset, and Units columns should update to the values 
just saved in the AuxTemp.ini file.
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Index
 A

absolute humidity, 15
advancing to the

next phase, 64
next point, 64

append to historical files, 61
assurance

conditions, 60
phase, 63

assured soak, 58
AT port adapter, 2
auto profile

assurance conditions, 60
assured soak, 58
clearing, 59
creating, 57
data acquisition, 64
flow rate, 58
historical data, 61
holding, 64
humidity control mode, 58, 59
manual override, 64
next phase, 64
next point, 64
phase and point, 63
printing, 62
ramp time, 58
recalling, 61
saturation temp, 58
saving, 61
saving as default, 61
starting, 62
stopping, 63
window, 58

auto profiling, 57
with data acquisition, 64

auxiliary
parameters, 19
temp probe calibration, 94

B
baud rate, 5

C
calculated humidity parameters, 4, 13
changing

control modes, 28
setpoints, 25
units, 26

channel monitor, 92
clearing

profile data, 59
report data, 47

collecting report data, 48
with 9800 Data Acquisition System, 49

comm port, 2, 5
communication

parameters, 5
settings, 5, 37

condensation, 24
configuration editing, 72
connecting

a printer, 35
to the generator, 2

control modes, 28
dew point, 29
frost point, 29
PPMv, 29
PPMw, 29
RH, 28
saturation pressure, 29

control parameters, 4, 12
copy graph, 42
creating

a profile, 57
a report, 49

current X, 42
custom

printer output, 36
report, 47
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D
data

graphing, 16
importing, 33
lines per page, 37
printing, 35
profile, 59
retrieving, 33
storage and retrieval, 31
storage interval, 31
strip chart, 16
tabular view, 18
temporary file, 31

data acquisition, 65
auxiliary temp probe calibration, 94
channel monitor, 92

changing channels, 93
channel pairing vs. meter pairing, 93
high priority/wait indicator, 93

daux.ini file, 85
Authorization, 86
Authorization2, 87
AutoClearRPTFiles, 92
AutoSaveDataFiles, 91
Averaging, 90
BaudRateA, 87
BaudRateB, 88
CommPortA, 87
CommPortB, 88
Compute, 89
CType, 86
DA2Temps, 89
DataAcqEnabled, 91
DataBitsA, 87
DataBitsB, 88
FlowA, 88
FlowB, 89
FromA, 89
FromB, 89
IDN, 86
LoadResistor, 90
Locked, 92
lockWhileRunning, 92
LongFileNames, 91
NPLC, 90
ParityA, 88
ParityB, 89
SaveConfigOnQuit, 91
ScanRate, 90
ScanRateMin, 90
ShowUnits, 90
SpecifiySignalGainAndOffset, 91

hardware connection

instruments, 69
instrument configuration, 74

active, 75
channels, 74
gain A, 77
gain B, 79
high signal A, 76
high signal B, 78
high value A, 76
high value B, 79
low signal A, 76
low signal B, 78
low value A, 76
low value B, 78
meas mode A, 76
meas mode B, 78
model, 75
offset A, 77
offset B, 79
serial, 75
tag, 75
units A, 77
units B, 80

instrument data, 83
active, 84
aux humidity, 85
aux temp, 85
channels, 83
humidity signal, 84
inst humidity, 84
inst temp, 85
model, 84
serial, 84
tag, 84
temperature signal, 84

interface, 66
setting up, 66
system configuration, 70

auxiliary humidity computations, 71
DA1 and DA2, 70
options, 71

temperature configuration, 80
active, 81
channels, 81
gain, 82
meas mode, 82
model, 81
offset, 82
probe ID, 82
serial, 81
tag, 81
units, 82

data averaging, 73
data bits, 5



Index 97

data storage & retrieval, 31
daux.ini file, 85
dew point, 14
dew point control mode, 29
directories, 2
disabling printer, 38
dry air density, 15

E
editing

axis limits, 43
graph legend, 45
report

data, 55
footer, 52
header, 51
test information, 53

enabling printer, 38
enhancement factor, 19
ensuring 9800 detection, 68
enthalpy, 15
error estimate, 13

F
F@PcTc, 20
F@PcTd, 20
F@PsTs, 20
file extensions

.dat, 10, 31

.ftr, 52

.hdr, 51

.msc, 54

.prf, 61
fit X, 42
fit Y, 42
flow, 5, 7, 24, 58
footer, 52
frost point, 14
frost point control mode, 29
full page printing, 36

G
generate mode, 23
generating, 23

modes, 28
setpoints, 25
shutdown, 30
startup, 23
units, 26

getting started, 1
changing %RH setpoint, 9

connecting to the computer, 2
generate mode, 5
installing ControLog, 1
setting communication parameters, 5
shutdown, 9
starting ControLog, 3

gradients
humidity, 24
temperature, 24

grains per pound, 14
graph, 4, 16, 41

copying, 42
data, 45
edit axis limits, 43
fit X, 42
fit Y, 42
grid, 45
legend

edit, 45
show, 44

markers, 45
menu, 8, 16, 43
new graph, 43
printing, 42, 45
shrink to fit, 42, 43
strip chart

disabling, 44
enabling, 44

time span, 43
title, 44
tool bar, 41
Y-axis title, 44
zoom, 41

grid, 45

H
hardcopy output, 35
header, 51
historical data, 60
hold point, 64
holding the profile, 64
HP34970A communication interface, 66
humidity control mode, 28
humidity gradients, 24

I
immediate printing, 39
import data, 33
inst data, 72
installing ControLog

directories created, 2
supporting files, 2
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instrument
data, 83
gain and offset, 72

integ time, 73

L
legend, 44
line at a time printing, 36
lines per page, 37
loading an existing profile, 61
LPT port, 35, 37

M
manual override of profile, 64
markers, 45
mean, 21
menus

!, 5, 37
file, 31
graph, 8, 16
mode, 28
profile, 59
report, 47
run, 5, 9, 23
units, 26
window, 11

minimize, 11
mixing ratio

by volume, 15
by weight, 15

mode
auto profile, 57
generate, 23
menu, 28

moist air density, 15
monitor, 73

N
new

graph, 43
header, 37
page, 37
profile, 59

next
phase, 64
point, 64

O
open profile, 61

P
page setup, 36
parallel printer connection, 35
parity, 5
partial dry air density, 15
parts per million

by volume, 14
by weight, 14

percent
by volume, 16
by weight, 16
relative humidity, 14

phase, 63
ramp, assurance, soak, 63

phase and point, 63
point (auto profile), 63
PPMv, 14

control mode, 29
PPMw, 14

control mode, 29
print

buffer, 39
graph, 42, 45
now, 39

printer
connecting, 35
customizing output, 36
enabling and disabling, 38
page setup, 36
port, 37

settings, 37
type of, 35

printing, 35
immediate data, 39
now, 39
profile, 62
report, 49
selecting the printer port, 37

profile, 19
creating, 68
data, 59
menu, 59
soak time, 58
units, 59
window, 19

R
ramp

phase, 63
timer, 63

raw signal data, 72
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recalling
report

footer, 53
header, 51
test information, 54

relative humidity, 14
report, 47

alternate data storage, 55
creating, printing, saving, 49
data, 55

clearing, 47
collecting, 48, 49
selecting, 55

editor, 47, 49
footer, 52

recalling, 53
saving, 52

default, 53
header, 51

recalling, 51
saving, 51

default, 52
menu, 47
test information, 53

recalling, 54
saving, 54

default, 55
reset, 12
retrieve

data, 33
saved profile, 61

RH, 14
RH@Pc, 14
RH@PcTc, 14
RH@PcTc control mode, 29
RS-232, 2
run menu, 5, 9, 23, 30

S
saturation pressure control mode, 29
saturation vapor pressure, 19
save data point now, 48
saving

profile, 61
report, 49
report footer, 52
report header, 51
report test information, 54
system data, 32

saving default
profile, 61
report footer, 53
report header, 52

report test information, 55
scan rate, 73
scientific notation, 27
selecting the test instrument data, 55
serial port, 2

settings, 5
setpoint changes, 6, 25
setting up for data acquisition, 66
show

grid, 45
legend, 44
markers, 45
profile window, 58

shrink to fit, 42, 43
shutdown, 30
SI units, 27
soak

phase, 63
time, 58

specific humidity, 15
spreadsheet, 18
stability, 21
standard deviation, 21, 60
starting auto profile, 62
startup, 23
statistical analysis, 21
status log, 4, 17

clearing, 17
printing, 17

stop bits, 5
stopping auto profile, 63
strip chart, 8, 16
supporting files, 2
SVP@Tc, 19
SVP@Td, 20
SVP@Ts, 20
system data, 18

file format, 32
importing, 33

if more than 1000 lines, 33
printing, 35
retrieving, 33
saving, 32
SI units, 31
splitting large files, 33
storage interval, 31
temporary file, 31

system status, 17
system timing, 18

T
tabular data, 18
temperature



100 Index

configuration, 80
gradients, 24

test
information, 53
temperature, 5

time span, 43
tolerance, 60
tool bar, 41

U
units

menu, 26
profile, 59
system, 26

V
vapor pressure, 19

with respect to ice, 20
with respect to water, 20

W
window

menu, 11, 12
reset, 12

windows, 11
auxiliary parameters, 19
calculated humidity parameters, 13
control parameters, 12
graph, 16
profile, 19
setting to power-up default, 12
statistical analysis, 21
status log, 17
system timing, 18
tabular data, 18

Y
Y-axis title, 44

Z
zoom, 41
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